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Apresentação

A exploração e o manejo dos recursos florestais naturais, madeireiros 
e não madeireiros, têm sido realizados pelas comunidades extrativistas 
da Amazônia, com pouco aporte de conhecimentos tecnológicos. 
A proposta de solução tecnológica apresentada neste estudo visa 
contribuir para a otimização dos traçados das trilhas para acesso aos 
recursos, otimizando o esforço e a energia para tal fim.

Atualmente é importante levar em consideração a racionalidade no 
uso dos recursos florestais, a fim de garantir a sua sustentabilidade. 
Na extração de produtos florestais não madeireiros, a otimização do 
traçado das trilhas de acesso permite reduzir o tempo para chegar até 
os indivíduos determinados, proporcionando ainda a minimização dos 
impactos ambientais decorrentes dessa atividade.

A utilização dessas novas tecnologias disponíveis certamente facilita 
esse processo, destacando-se, nesse caso, os Sistemas de Informações 
Geográficas (SIGs). Portanto, este trabalho apresenta a metodologia 
detalhada para traçado de trilhas por meio de análises de redes, com as 
etapas implementadas em ambiente SIG.

Celso Paulo de Azevedo
Chefe-Geral Interino
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Introdução

É notável a importância das florestas tropicais, com imensa reserva 
em biodiversidade, principalmente pelas riquezas naturais e o papel 
socioambiental que desempenham. As florestas fazem parte da vida 
cotidiana de pessoas diretamente ligadas a elas, seja como forma de 
subsistência, seja como fonte de renda. Neste contexto, cada vez 
mais têm-se buscado soluções tecnológicas que possibilitem  o melhor 
aproveitamento dos recursos, com benefícios mútuos entre o homem 
e a floresta, visando aumentar a produtividade de forma sustentável,  
otimizando o tempo e o esforço laboral para a coleta e extração de 
determinado produto, seja ele madeireiro ou não. 

A otimização do traçado de trilhas visa identificar o melhor percurso, 
combinando diversos fatores que determinam o grau de dificuldade 
de se percorrer determinada região e uma  maior eficiência de 
acesso a árvores ou a áreas de manejo de interesse. Os estudos de 
variáveis regionalizadas, tais como a cobertura vegetal e o uso da 
terra, hidrografia e relevo (Modelos Digitais de Elevação – MDEs), 
caracterização e modelagem, auxiliam sobremaneira a tomada de 
decisões sobre o manejo. Assim, a otimização do acesso às áreas 
de exploração é vital não só para redução de esforço na coleta, mas 
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também nos impactos ambientais decorrentes do estabelecimento, do 
uso e da manutenção de trilhas de acesso inadequadas e até mesmo 
desnecessárias.

Os Sistemas de Informações Geográficas (SIGs) são a base para 
diversos processos na geração de tecnologias, realçam a importância e 
a versatilidade do emprego de informações de natureza intrinsecamente 
espacial. Aliados aos contínuos avanços na área computacional, o 
domínio e a adoção do SIG para modelagem e resolução desse tipo de 
problema são cada vez mais difundidos, proporcionando solução prática 
para o problema de rotas otimizadas com melhoras significativas. Isso 
é particularmente percebido no que se refere à melhor compreensão da 
complexidade do cenário e da avaliação das alternativas.

O principal objetivo deste documento é contribuir para ampliar o 
conhecimento e difundir a aplicação das funcionalidades básicas 
relacionadas às análises de redes para otimização de trilhas, visando 
ao acesso aos recursos naturais, com as etapas implementadas em 
ambiente SIG.

Preparação do ambiente SIG para as análises

Todas as etapas dos procedimentos a seguir tiveram como base o 
software ArcGIS versão 10.3 (ESRI, 2014). O primeiro passo é a 
organização dos dados obtidos, criados ou processados. Para isso, 
é imprescindível a criação de uma Geobase, que pode ser definida 
como um banco de dados espaciais que armazena informações 
georreferenciadas, vinculando-lhes atributos descritivos, organizados 
como classe de feições1.

Para criar uma Geobase acesse o ArcCatalog e, por meio dos 
menus, selecione “New>File Geodatabase”, nomeando-o por 
exemplo como “utm_19s”, e depois “New>Feature Dataset”, 
nome ”dados”, definindo-se, ao final do procedimento, o nome do 

1Classes de feições são coleções temáticas de feições vetoriais elementares (pontos, 
linhas, polígonos).
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projeto e o sistema de projeção/coordenadas que será utilizado em 
todo o projeto (no presente caso, Sistema de Coordenadas UTM, 
Datum WGS84). Sugere-se também desabilitar o processamento em 
segundo plano, a fim de possibilitar a visualização do progresso de 
cada etapa do processamento. Para tal, no menu principal clique em 
“Geoprocessing>Geoprocessing options” e, na janela que se abre, 
desabilite a opção “Enable”.

Para os diversos processamentos desse roteiro, algumas extensões 
do ArcMAP deverão ser habilitadas. Na barra de menu, selecione 
“Customize > Extensions...”. Na janela aberta habilite as opções “3D 
Analyst”, “Network Analyst” e “Spatial Analyst” (Figura 1).

Figura 1. Destaque do 
processo para habilitar 
extensões necessárias para 
os processamentos.

É importante destacar que todos os arquivos gerados ao longo 
dessa metodologia devem conter em seu nome final um indicativo 
do processo que o gerou, a fim de facilitar os processamentos 
subsequentes, sendo estes salvos nas geobases criadas ao longo do 
processo.

Obtenção dos dados necessários

O conjunto de dados necessários para reprodução dessa metodologia 
estará disponível no link: https://www.embrapa.br/metodologia-de-
otimizacao-do-tracado-de-trilhas-para-acesso-a-recursos-florestais-
naturais
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Modelo Digital de Elevação (MDE)

Características gerais
O MDE consiste em um modelo de dados espacial, que define o espaço 
como uma matriz de células de mesmo tamanho, dispostas em linhas e 
colunas, com valores de atributo para cada célula. Células com valores 
iguais representam características geográficas semelhantes. Uma das 
fontes mais utilizadas atualmente para as análises ambientais são 
dados de elevação da superfície terrestre, obtidos por sensoriamento 
remoto orbital. A disponibilização gratuita de diversas bases de dados 
globais é crescente; entre elas está o  projeto Shuttle Radar Topography 
Mission (SRTM), iniciado em fevereiro de 2000 com o objetivo de 
produzir MDEs para toda a superfície terrestre, adotando-se a mesma 
metodologia do início ao fim (FIGUEIREDO et al., 2007; MIRANDA, 
2015). 

Os dados SRTM são disponibilizados gratuitamente a qualquer usuário 
pelo Serviço Geológico dos Estados Unidos (USGS), com células de 
30 m de lado (um arco-segundo), cobrindo, dessa forma, áreas de 900 
m2. A contínua evolução desse segmento e a importância estratégica 
desses dados em inúmeras aplicações têm resultado em MDEs com 
resolução espacial cada vez maior, i.e., com células cada vez menores. 

Obtenção do MDE
Os dados altimétricos do MDE foram extraídos da base SRTM de maior 
detalhamento atualmente disponível (30 m ou um arco-segundo). 
O banco de dados dessas cenas está disponibilizado no website do 
USGS*. 

No site do USGS há três maneiras para se obter os dados da área de 
interesse: 1) Figura 2A – Inserindo as coordenadas em graus/minutos/
segundos ou decimal, manualmente, ou com um clique simples em 
um ponto desejado do mapa; 2) Figura 2B – Fornecendo os vértices 

2http://earthexplorer.usgs.gov/
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da área de estudo, via formato Keyhole Markup Language (kml) ou 
da importação direta de shapefile (feição vetorial), em coordenadas 
geográficas (latitude e longitude); 3) Figura 2C – Simplesmente 
definindo manualmente uma área temporária em “Use Map”. Assegure-
se de que todos os arquivos que compõem o shapefile estejam em uma 
única pasta zipada.

C

B

A

Figura 2. A) Processo de 
identificação da área de estudo. 
Inserção de coordenadas com o 
clique do mouse; B) Importação 
de um shapefile ou Kml com os 
limites da área de estudo; C) 
Definição manual de área usando 
o mapa como referência. 

Após a definição da área de interesse, na aba “Data sets” seleciona-
-se, dentre os vários conjuntos de dados disponíveis, os dados SRTM, 
acessados em “Select Your Data Set(s)” > “Digital Elevation” > SRTM 
> SRTM 1 Arc-Second Global” e, em seguida, clica-se em “Results” 
(Figura 3A). Após realizar a pesquisa, todas as cenas disponíveis para 
aquela região, tomadas em várias ocasiões, são exibidas na Figura 
3B. Depois de identificada e escolhida a cena de interesse, realiza-se 
o download clicando-se na opção “Download Options”. Deve-se dar 
preferência ao formato “GeoTIFF 1 Arc-second” (Figura 4), que produz 
arquivos no formato “.tiff”, que podem ser visualizados diretamente em 
diversos aplicativos. Se existirem diversas imagens recobrindo a área de 
estudo, é mais conveniente baixá-las usando o utilitário Bulk Download 
Application (ícone logo à direita da opção Download), também 
disponível no site do USGS.

Fonte: USGS
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BA

Figura 3. A) Destaque para a seleção dos dados 
SRTM, pesquisa no banco de dados; B) Download da 
cena. 

Figura 4. Sequência para adicionar a imagem SRTM e mapear o diretório para 
conectá-lo ao ArcMap.

Fonte: USGS
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Carregando o MDE no ArcGIS (ArcMap)

O primeiro passo ao se utilizar o MDE é saber qual o Sistema de 
Coordenadas e Datum correspondente, assegurando-se que todos os 
dados utilizem a mesma referência espacial. Segundo as resoluções 
01/2005, de 25 de fevereiro de 2005, e 01/2015, de 25 de fevereiro 
de 2015, da Presidência da República, o Datum padrão adotado para 
o Brasil é o SIRGAS2000 ou o WGS84, que é o Datum mais próximo 
deste. 

A partir desse ponto, todos os procedimentos serão realizados no 
software ArcGIS 10.3 (ESRI, 2014), com o uso de suas ferramentas e 
extensões necessárias à aplicação no estudo de caso proposto. Com 
o ArcMap já iniciado e em sua interface principal, carregue a imagem 
SRTM por meio da opção “Add Data” e, se for necessário, mapeie a 
pasta de trabalho contendo a imagem SRTM baixada, utilizando o ícone 
“Connect To Folder” (Figura 4). Essa operação facilitará posteriores 
acessos ao diretório mapeado.

Conversão do MDE para coordenadas planas UTM
As análises de redes dependem intrinsecamente do cálculo das 
distâncias que, por sua vez, devem necessariamente estar expressas 
em unidades lineares (metros, quilômetros, pés, milhas etc). O MDE 
baixado do USGS possui coordenadas geográficas com distâncias 
sendo expressas em unidades angulares (graus decimais). Assim, 
esses MDEs precisam ser previamente reprojetados para um sistema 
de coordenadas planas. Quando a região de estudo não se estender 
por mais de uma zona Universal Transverse Mercator (UTM) ou não 
tiver mais que 6º de largura (~ 666 km próximo ao Equador), pode-se 
adotar a projeção UTM. Dado que todas as cenas da base SRTM estão 
no Datum WGS84, não será necessário convertê-lo. Entretanto, há que 
se saber previamente em qual zona UTM se localiza a região de estudo. 
No presente caso, a área situa-se na zona UTM 19, Sul. Destaca-se 
que, para essa cena de imagem, o fuso é 19 e o meridiano central, 
-69º, e está localizado no Hemisfério Sul, sendo que essa definição 
varia com a localização da região de estudo.
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Figura 5. Caminho de acesso e destaque para a ferramenta “Project Raster” 
com as respectivas  configurações definidas.

Para essa etapa usa-se a caixa de ferramentas do ArcToolbox: “Data 
Management Tools > Projections and Transformations > Raster > 
Project Raster” (Figura 5). Na janela que se abre, seleciona-se a imagem 
SRTM de interesse em “Input Raster”; em seguida, a pasta de destino, 
definindo-se o nome para o novo arquivo gerado em “Output Raster 
Dataset”. No campo “Output Coordinate System”, seleciona-
-se o sistema de coordenadas projetadas UTM “WGS 1984 UTM Zone 
19S” (área de interesse). Para não se alterar os valores originais de 
altimetria, deve-se deixar o valor NEAREST assinalado por default à 
opção “Resampling Technique”. Em “Output Cell Size”, deve-se ajustar 
o tamanho do pixel para 30 m em “X” e “Y” (Figura 5). 

Recorte do MDE para o local de interesse
Nesta última etapa de preparação do MDE, deve-se recortar a imagem 
para o limite da área de estudo. Para fazer o recorte do MDE é 
necessário ter definidos, em formato vetorial, os limites da área de 
interesse, que servirá de “máscara” para o recorte da imagem. 

Primeiramente adicione a camada vetorial da área de interesse. Essa 
etapa é realizada com a extensão “Spatial Analyst Tools > Extraction 
> Extract by Mask” (Figura 6A). Na janela que se abre, selecione a 
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Figura 6. Recorte do MDE nos limites da área de estudo por meio da ferramenta 
“Extract by Mask”: A) Acesso à ferramenta “Extract by Mask”; B) Entrada 
(input) e saída (output) dos dados recortados. 

Figura 7. Imagem raster SRTM recortada nos limites da área de estudo. 

imagem raster de interesse em “Input raster” e a camada vetorial que 
servirá para recorte da imagem em “Input raster or feature mask data”, 
especificando-se, em seguida, o destino/nome da imagem final em 
“Output raster” (Figura 6B). 

Ao final do processo, será gerada uma nova imagem raster com as 
mesmas características cartográficas da imagem original, porém com 
informações somente dentro do limite da área de interesse (Figura 7).
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Modelo digital de elevação
hidrograficamente condicionado

A rede hidrográfica é de extrema importância para a determinação de 
caminhos otimizados, por serem barreiras físicas ou fator de impedância 
distinta no traçado para acesso aos recursos florestais. Esse fato é 
particularmente relevante para a Bacia Amazônica. O MDE isoladamente 
possui pouca precisão em seus dados finais para análises hidrológicas, 
sendo necessários diversos pré-processamentos para que se obtenha 
uma representação fidedigna do escoamento das águas superficiais. 
Esses procedimentos visam à padronização na geração de MDEs ditos  
Hidrograficamente Condicionados (MDEHC) (MACHADO et al., 2010; 
MARTINS et al., 2011).

O MDEHC permite que as delimitações de bacias hidrográficas sejam 
realizadas com maior precisão, por assegurar que o escoamento 
originado a partir de qualquer ponto do relevo convirja para um ponto 
da malha hidrográfica e, a partir daí, para a respectiva foz. Essa 
categoria especial de MDEs caracteriza-se por apresentar coincidência 
considerável com a rede de drenagem real (RIBEIRO et al., 2005; 
MARTINS et al., 2011).

Outra opção mais acurada seria o mapeamento detalhado da rede 
hidrográfica com dados mais precisos; entretanto, os seus custos 
acabam sendo muito mais elevados quando comparado à modelagem 
hidrológica. Assim, a escolha final dependerá dos objetivos e das  
características gerais do local, como tamanho da área de estudo, maior 
precisão dos dados, menor custo etc.

Eliminação de sumidouros espúrios
Sumidouros espúrios, também denominados de depressões espúrias, 
são falhas nos valores de altimetria que prejudicam os estudos 
hidrográficos. Basicamente podem ser definidos por áreas ou pixels 
rodeados por elevações com valores de cotas superiores, funcionando 
como uma espécie de ralo na rede de drenagem, interferindo 
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diretamente no escoamento superficial. Portanto, a correção prévia do 
MDE é necessária.

Para essa etapa é utilizada a extensão “Hidrology” disponível no 
“ArcToolbox”, acessada em “Spatial Analyst Tools > Hidrology > Fill” 
(Figura 8). Na janela que se abre, adicione o MDE em “Input Surface 
Raster” e defina o local para salvar o arquivo de saída em “Output 
surface raster”, nomeando-o como (mde_UTM_fill). Ao final será gerado 
um novo MDE visualmente igual ao anterior, entretanto, internamente, 
com as depressões espúrias corrigidas.

Figura 8. Caminho de acesso e destaque para a ferramenta “Fill” e as 
configurações definidas.  

Há que se destacar que a visualização 3D do relevo, na Figura 8, foi 
obtida por meio da geração da feição “mde_UTM_sombra”, gerada por 
uma ação opcional. Essa operação pode ser realizada utilizando-se a 
ferramenta Hillshade, acessada em “Spatial Analyst Tools > Surface > 
Hillshade”. Para tal, carrega-se o MDE_fill, definindo o local para salvar 
o arquivo que será adicionado ao projeto. Posteriormente, na janela 
de conteúdos, certifique-se de que a camada sombra gerada esteja 
acima do “MDE fill”, na tabela de conteúdos. Em seguida, com o botão 
direito sobre a camada da sombra, vá até “Properties...”, e então, na 
janela que se abre, selecione a aba “Display” e defina: em “Resample 
during display using” e escolha “Bilinear Interpolation (for contínuos 
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data)”, esse mesmo processo deve ser feito no arquivo do MDE; em 
“Transparency” atribua o valor da porcentagem de transparência, que 
nesse caso foi usado 75%.

Derivação da drenagem numérica do terreno
Os passos seguintes têm por objetivo derivar o traçado da rede 
hidrográfica com base no MDE. Primeiro, deve-se acessar a ferramenta 
“Flow direction”, objetivando calcular a direção de escoamento 
para cada pixel, com base nas cotas do terreno. Para essa etapa é 
importante que as depressões espúrias já estejam corrigidas, caso 
contrário ocorrerá erro na drenagem numérica. Todos os valores 
de escoamento em direção a outro pixel assumem sempre valores 
referentes à potência de 2 (20 = 1, 21 = 2, 22 = 4, 23 = 8, 24 = 
16, 25 = 32, 26 = 64, 27 = 128). Esse é o padrão de codificação 
implementado no ArgGIS (Figura 9).

Figura 9. Direção de escoamento para pixels 
adjacentes e seus respectivos valores para 
cada direção. 

3A opção marcada é especialmente importante para os casos em que  o perímetro da área 
de estudo se estender por uma margem de pelo menos 1 célula de largura, ao redor do 
divisor de águas.

Para acessar essa ferramenta, no ArcToolbox, acesse “Spatial Analyst 
Tools > Hidrology > Flow Direction”. Na janela que se abre, adicione 
em “Input surface raster” a imagem gerada no processo anterior pela 
ferramenta “Fill” e, em seguida, especifique o arquivo de saída em 
“Output flow direction raster” com a opção “Force all edges cells to 
flow outward”3 marcada (Figura 10).
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Figura 10. Acesso e destaque para a ferramenta “Flow Direction” e as 
configurações definidas. 

Figura 11. Resultado do processo de identificação  da direção de 
escoamento(“Flow Direction”) de cada pixel, sendo Value = valor da direção de 
fluxo; Count = quantidade de pixels em uma dada direção. 

O resultado é uma nova imagem, evidenciando a direção de fluxo de 
cada pixel, como mostrado na tabela de atributos (Figura 11). Como 
dica de validação desse resultado, ao se observar na tabela valores 
que não sejam potência de 2, significa que há presença de sumidouros 
ou depressões espúrias. Caso isso venha a ocorrer, deve-se aplicar 
novamente o comando “Fill” e recalcular as direções de escoamento. 
É importante ressaltar que quanto mais marcante for o relevo, ou seja, 
maior a diferença entre as cotas dos pixels, mais visível será o fluxo de 
direção.  No presente estudo de caso, a área de estudo não apresenta 
direção do fluxo constante.
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Definidas as direções de fluxo, pode-se então calcular a área existente 
acima (área a montante) de uma célula ou pixel. As células com 
maiores valores estão geralmente associadas a fundos de vales, 
sendo, portanto, indicadoras da hidrografia. Para derivar o grid de 
fluxo acumulado, usa-se a ferramenta “Flow Accumulation”, disponível 
em “Spatial Analyst Tools > Hidrology. Em seguida, insira em “Input 
flow direction raster” a imagem processada pela função “Flow 
Direction” e em “Output accumulation raster” indique o diretório para 
salvar o arquivo de saída. Deixe vazio o campo  em “Input weight 
raster (optional)” e selecione “Float” (valor acumulado) em “Output 
data type (optional)” (Figura 12). Destaca-se que o resultado desse 
processamento gera uma imagem que permite inferir a localização da 
hidrografia, com células de maior valor de escoamento representadas 
por tons claros de cinza.

Figura 12. A) Caminho de acesso e destaque para a ferramenta “Flow 
Accumulation” e as configurações definidas; B) Resultado do processo de 
cálculo do fluxo acumulado, destacando-se as redes hidrográficas principais em 
tons mais claros.

A B

Identificação do trajeto a jusante de um ponto
Para um traçado mais próximo do real, com a modelagem da hidrografia 
a partir do MDE, é importante incluir a localização geográfica de cada 
nascente de corpos d’agua dentro da área de estudo, para assim 
identificar o trajeto a jusante desses pontos. Essas localizações podem 
ser obtidas das seguintes formas: (a) por meio de coletas em campo 
das coordenadas de cada nascente, com uso de receptor GPS; (b) 
virtualmente por meio da imagem de direção de acumulação gerada 
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Figura 13. Feição vetorial de 
pontos das nascentes adicionadas 
ao projeto (pontos verdes).

na etapa anterior; (c) a partir de imagens de satélite mais detalhadas; 
ou, ainda, (d) seguir com o ordenamento da hidrografia de acordo com 
metodologia definida em Figueiredo et al. (2007). Essa etapa serve para 
refinar as análises quando se tem em mãos um conjunto de dados mais 
completo.

Neste estudo de caso, será adicionado ao ArcMap a feição vetorial tipo 
ponto com a localização das nascentes (Figura 13).

Para o cálculo do trajeto a jusante, a partir do MDE e das nascentes, 
será utilizada a ferramenta “Cost Path”. Essa ferramenta calcula o 
caminho de menor impedância a partir de origens e um destino, com 
base em um custo associado ao percorrer uma superfície. Para isso, 
acesse, no ArcToolbox, “Spatial Analyst Tools > Distance > Cost 
Path”. Na janela que se abre, adicione a feição vetorial de pontos 
das nascentes em “Input raster or feature destination data”; deixe 
“OBJECTID” como padrão no campo “Destination field (optional)”. Em 
“Input cost distance raster”, adicione a imagem corrigida de depressões 
espúrias, gerada no processo “Fill”; em “Input cost backlink raster”, 
adicione a imagem gerada pelo processo “Flow direction”. Defina o 
nome “hidro_nasc” e local para salvar o arquivo de saída em “Output 
raster”, e, em “Path type” selecione “EACH_CELL”, ou seja, caminho 
passando por cada célula raster (Figura 14). Os valores de elevação 
representam o grau de dificuldade (impedância) de se mover de uma 
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célula para outra; assim, a direção de movimentação entre duas 
células vizinhas será ditada pela inclinação do segmento mais íngreme 
conectando o centro de duas células adjacentes. Já o grid “Cost 
Backlink raster” fornece, em última análise, a direção de uma célula 
qualquer para se retornar à origem. Como a(s) foz(es) é(são) tratada(s) 
como origem(ns) – e as nascentes, como destinos –, as direções de 
fluxo representam adequadamente as conexões (links) no sentido 
inverso (back).

Figura 14. Caminho de acesso e destaque para a ferramenta “Cost Path” e as 
configurações definidas. 

Antes de finalizar esse processo, é importante configurar o ambiente 
para análises, assegurando que o processamento ocorra da maneira 
correta. Para isso clique na opção “Environments...”, ainda na Figura 
14, e acesse o item “Processing Extent” (Figura 15A) selecionando a 
imagem gerada no processo “Fill” como extensão do processamento 
e também para a opção “Snap raster” (Figura 15B). Na Figura 15C, 
selecione o item “Raster Analysis”: em “Cell size” e “Mask”, selecione 
a mesma imagem gerada pelo processo “Fill”. Essa configuração 
permite ao software fazer o processamento somente para extensão do 
MDE da área de estudo, impondo-se o tamanho da célula de 30 m.

Ao final do procedimento, é gerada a segmentação da hidrografia a 
partir dos pontos de nascentes, direção de fluxos e fluxo acumulado, 
com base no MDEHC gerado com os dados SRTM (Figura 16).
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Figura 15. Configuração do ambiente para o processamento, com opções 
“Processing Extent” (A) e (B) e “Raster Analysis” (C).

Figura 16. Resultado da segmentação 
da hidrografia a jusante de um ponto.

As células de cada segmento da hidrografia recebem o valor assinalado 
como identificador da respectiva nascente; quando dois trajetos 
convergem, as células do trajeto a jusante do ponto de convergência 
até a respectiva foz recebem um novo valor, diferente de todos os 
identificadores das demais células. Se um trajeto convergir para um 
trajeto já existente, as células do trajeto a jusante da confluência 
manterão os valores já assinalados. 

A

B C
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Vetorização da rede hidrográfica
Nesta etapa, a rede hidrográfica gerada no processo anterior será 
apropriadamente segmentada e convertida para feição vetorial tipo 
linha, possibilitando sua posterior utilização nas análises de redes.

Para conversão da segmentação da hidrografia para o formato vetorial 
tipo linha, deve-se acessar a ferramenta “Stream to Feature” disponível 
em “Spatial Analyst Tools > Hidrology > Stream to Feature” (Figura 
17). Na janela que se abre adicione em “Input stream raster” a 
hidrografia gerada no último processo a partir das nascentes e, em 
“Input flow direction raster”, o raster gerado no processo de direção 
de fluxo. É extremamente importante desabilitar a opção “Simplify 
polylines (optional)”, ou seja, não se deseja simplificar linhas, pois o 
objetivo é que seja seguido exatamente o trajeto célula a célula.

Figura 17. Acesso e destaque para a ferramenta “Stream to Feature” e as 
configurações definidas. 

Os segmentos vetoriais resultantes dessa operação são armazenados 
em uma classe de feições (Output polyline features) e estão todos 
automaticamente orientados no sentido correto do escoamento das 
águas superficiais, i.e., na direção da respectiva foz (Figura 18).

Na Figura 18, selecione uma nascente e amplie a imagem (zoom 
+)  de modo a se visualizar os pixels, a fim de se  perceber que o 
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segmento vetorial cruza as nascentes até à borda do pixel, passando 
da localização da nascente (Figura 19). Isso é um problema há 
muito identificado no uso do comando “Stream to Feature”. A 
ferramenta “Raster to Polyline” evita esse problema; entretanto, tem 
o inconveniente de não assinalar corretamente a respectiva direção 
de escoamento de cada arco. Vale salientar que cada pixel cobre uma 
área de 900 m2; consequentemente, a localização de uma nascente 
coletada com receptor GPS em qualquer ponto dentro de um pixel não 
terá detalhes suficientes para distinção, sendo que somente o pixel 
inteiro é considerado nas análises. Assim, as nascentes foram alocadas 
sistematicamente no centro de cada pixel.

Figura 18. Resultado da conversão 
da hidrografia rasterizada em feições 
vetoriais do tipo linha, com as 
respectivas direções do escoamento. 

Figura 19. Localização da nascente 
no centro do pixel, evidenciando o 
erro do segmento da hidrografia, 
que  ultrapassa o ponto da nascente, 
necessitando de correções adicionais.
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Para se eliminar a porção do segmento que se estende além da 
respectiva nascente, utiliza-se a ferramenta “Snap” para fins de ajuste 
e aderência, disponível em “Editing Tools > Snap” no ArcToolbox 
(Figura 20). Em “Input Features” insira a hidrografia vetorial gerada 
no último processo e, em “Snap Environment”, carregue a feição tipo 
“pontos” contendo a localização das nascentes; clique em “Type” e 
selecione a opção “END”. No campo “Distance”, digite o valor 22 
(Figura 20). Automaticamente essa ferramenta ajusta a hidrografia 
finalizando nos pontos das nascentes; como o segmento poderá se 
estender na diagonal, o valor correto para o parâmetro “Distance” será 
igual à metade do tamanho da célula multiplicado pela raiz quadrada de 
2. O valor 22 equivale à metade da diagonal do pixel, arredondado para 
o maior inteiro, calculado por trigonometria a partir da dimensão do seu 
lado (30 m), i.e.,15√2.

Figura 20. Caminho de acesso à ferramenta “Snap” e suas configurações 
definidas. 

O próximo passo é realizar a segmentação da hidrografia propriamente 
dita. Segmentos são seções de uma rede hidrográfica conectando: (a) 
uma nascente a uma confluência; (b) duas confluências consecutivas; 
ou (c) uma confluência à foz. Na representação matricial (raster), 
cada segmento é assinalado com um identificador único, sendo que 
todas as células de um dado segmento recebem esse mesmo valor. 
Para efetuar a identificação dos segmentos da hidrografia, é utilizada 
a ferramenta “Stream Link”, disponível em “Spatial Analyst Tools 
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Figura 21. Caminho de acesso e destaque para a ferramenta “Stream Link” e as 
configurações definidas.

> Hidrology > Stream Link” (Figura 21). Na janela que se abre, em 
“Input stream raster”, adicione a hidrografia no formato raster, gerada 
a partir do traçado a jusante de um ponto (“hidro_nasc” e, em “Input 
flow direction raster”, adicione o raster gerado no processo de direção 
do fluxo. Por último, selecione o diretório para salvar o novo arquivo 
gerado digitando o nome “hidro_seg”.

Ordenamento da rede hidrográfica
Ordenamento da hidrografia é um método para atribuir códigos 
numéricos aos segmentos de uma rede (ESRI, 2016). Para realizar essa 
ação, o ArcMap disponibiliza a ferramenta “Stream Order”, em “Spatial 
Analyst Tools > Hidrology > Stream Order” (Figura 22). Na janela que 
se abre, em “Input stream raster”, insira o mesmo raster da hidrografia 
gerada no processo da jusante de um ponto (hidro_nasc) e também o 
raster de direção do fluxo em “Input flow direction raster”; em “Output 
raster”, insira o nome “hidro_shreve” e o diretório de destino. Em 
”Method of stream ordring (optional)”, escolha “SHREVE”.

Para o ordenamento da hidrografia, o ArcMap disponibiliza duas 
opções em “Method of stream ordering (optional)” (Figura 22): 
Strahler (1952) e Shreve (1966). O método de Strahler designa, 
como de primeira ordem, todos os segmentos da hidrografia sem 
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afluentes. i.e., aqueles que têm por origem uma nascente (ordem 1). 
A ordem do fluxo (segmento) aumenta somente quando fluxos da 
mesma ordem se interceptam (Figura 23). Assim, a interseção de dois 
segmentos de primeira ordem resultará em um segmento de segunda 
ordem imediatamente a jusante; a interseção de dois segmentos de 
segunda ordem dará origem a um de terceira ordem, e assim por diante 
(STRAHLER, 1952; ESRI, 2016).

Figura 22. Caminho de acesso e destaque para a ferramenta “Stream Order” e 
as configurações definidas. 

Figura 23. Ordens dos segmentos de 
acordo com os métodos de Strahler e 
Shreve. 

Fonte: Adaptado de ESRI (2016).

Algumas características acerca dos rios podem ser diretamente 
inferidas a partir de sua ordem. Por exemplo, como os rios de cabeceira 
não recebem aporte de nenhum tributário, eles são muito mais afetados 
pelo escoamento superficial na respectiva área de drenagem. Qualquer 
contaminação dessas áreas poderá atingir a nascente, propagando-
-se rio abaixo. Por isso, as bacias de cabeceira são mais suscetíveis 
à contaminação difusa. Zonas de proteção ripárias mais largas ao 
longo dos rios de primeira ordem produzem proporcionalmente mais 
benefícios ambientais do que aquelas estabelecidas em outras áreas 
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Figura 24. Resultado do ordenamento 
da hidrografia pelo método de Shreve.

da bacia hidrográfica (ESRI, 2016). Não por acaso, o Código Florestal 
Brasileiro anterior (Lei nº 4.771) considerava esses espaços como 
Áreas de Preservação Permanente (RIBEIRO et al., 2005).

No método de Shreve, a ordem de um dado segmento reflete o número 
de tributários de primeira ordem e, consequentemente, o número 
de nascentes existentes a montante. Assim, a ordem de qualquer 
segmento é calculada somando-se a ordem dos dois segmentos que 
lhe dão origem (Figura 25) (SHREVE, 1966; ESRI, 2016). Nesse 
documento foi utilizado o método de Shreve, tendo como resultado a 
identificação da ordem de cada segmento (Figura 24).

Análise de redes

Os próximos passos norteiam a construção de uma rede para simular 
o deslocamento ao longo do terreno, tendo como custo desse 
deslocamento a impedância, a declividade e a presença de rede 
hidrográfica. Por se tratar de vários processos no qual se deve utilizar 
a feição correta para o sucesso do procedimento, será sugerida uma 
nomenclatura a ser adotada para cada resultado.

O ambiente raster viabiliza uma série de recursos para se identificar 
o melhor percurso conectando uma origem a um destino. Entenda-
se “melhor” como: menor custo, menor distância, menor tempo, 
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mais seguro, de maior beleza cênica etc. Essa situação caracteriza 
o problema de se projetar um novo trecho de uma malha viária, de 
uma maneira ótima, possibilitando considerar diversos custos (de 
desapropriação, de corte e aterro, de pavimentação, de construção 
de pontes, túneis, viadutos), bem como barreiras absolutas (regiões 
urbanas, áreas de proteção ambiental, terras indígenas) e relativas 
(tipo de solo, declividade, cobertura vegetal e uso da terra) ao longo 
da análise. Um exemplo clássico é o estabelecimento ótimo de uma 
rede de estradas para exploração florestal de um novo projeto de 
reflorestamento. Há, entretanto, uma série de outros problemas 
envolvendo deslocamentos, que não podem ser modelados em uma 
representação raster.

O universo das análises de redes em ambiente vetorial complementa 
e amplia consideravelmente os recursos existentes no mundo raster. 
Citam-se as seguintes classes de problemas que se beneficiam 
sobremaneira dessa estrutura particular de representação espacial:

•	 Instalação mais próxima (onde está o posto de gasolina mais 
próximo?);

•	 Localização-alocação (qual é o melhor local para se instalar um 
novo supermercado?);

•	 Menor caminho (qual o trajeto mais rápido para se chegar ao 
aeroporto, na hora do almoço?);

•	 Abrangência (que regiões estão a até 20 minutos de cada uma das 
escolas da cidade?);

•	 Roteamento (qual a melhor sequência para o carteiro entregar todas 
as correspondências?);

•	 Matriz de custos (determinar todas as combinações para se 
conectar n origens a m destinos).

Todas as análises de redes requerem, a priori, a existência de uma rede 
de arcos conectados, com as respectivas impedâncias (atritos, custos) 
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de se percorrê-los em um sentido ou outro. O problema de coleta de 
castanhas envolve, essencialmente, identificar a sequência ótima das 
castanheiras a serem visitadas e, considerando-se as peculiaridades 
do terreno (relevo, vegetação, hidrografia), estabelecer o melhor 
traçado das trilhas conectando esses pontos. A modelagem matricial 
permitiria identificar o menor caminho conectando, célula a célula, 
duas castanheiras, mas não o menor caminho conectando todas elas 
e, mais limitante ainda, a ordem em que deveriam ser visitadas. Já a 
modelagem vetorial – análise de redes – permite identificar a sequência 
ótima e o menor percurso para se visitar todas as castanheiras; porém, 
há que se fornecer, de antemão, os trajetos conectando as diversas 
castanheiras. Para se resolver esse impasse, desenvolveu-se aqui uma 
abordagem híbrida, que utiliza uma estrutura vetorial para estabelecer 
a conexão entre células vizinhas, possibilitando identificar a sequência 
ideal e o melhor caminho para se coletar os frutos das diversas 
castanheiras, contemplando todas as rotas possíveis.

Para minimizar as eventuais distorções que inevitavelmente surgirão nos 
inúmeros processos de rasterização de dados vetoriais e vetorização de 
dados raster, deve-se garantir a manutenção da resolução geométrica 
para ambos os modelos de dados, i.e., raster e vetorial. Isso significa 
que a distância mínima entre dois vértices consecutivos de um arco 
deverá ser igual ao tamanho da célula do raster, o que resultará em 
contornos vetoriais serrilhados, ao invés de curvas suaves, de estética 
realmente bem menos agradável aos olhos. Longe de representar 
qualquer limitação mais séria, essa correspondência biunívoca entre 
raster e vetor é essencial para assegurar a unicidade dos resultados, 
independentemente do modelo de dados adotado para realizar as 
tarefas. Assim, a rasterização de uma hidrografia vetorial “hv1”, 
obtida a partir da vetorização de uma rede hidrográfica raster “hr1” 
(obtida, por exemplo, a partir da identificação automática do trajeto a 
jusante das nascentes), deverá resultar em uma nova hidrografia raster 
“hr2” idêntica a “hr1”. Analogamente, a vetorização da hidrografia 
raster “hr2” deverá resultar em uma nova hidrografia vetorial “hv2”, 
necessariamente idêntica a “hv1”.
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Figura 25. Criação da Geobase e classes de feições para 
armazenamento de dados.

Figura 26. Importação de diversos rasters para o Geobase.

Conversão de células raster em malha regular de 
pontos altimétricos
Para organização dos dados a serem utilizados e produzidos ao longo 
deste projeto, clique em Catalog e, na janela que se abre, crie um nova 
Geobase com o nome de “Trilhas”. Dentro dela, crie um novo conjunto 
de classes de feições (“Feature Dataset”), nomeando-o “Trilhas_
WGS84_UTM” (Figura 25).

Importe para a Geobase criada, o MDE gerado pelo processo “Fill” e 
a hidrografia ordenada pelo método de Shreve. Para isso, posicione o 
cursor sobre o nome da Geobase e clique com botão direito do mouse. 
Clique na opção Import e, na lista seguinte, clique na opção “Raster 
Datasets” (Figura 26).
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Figura 27. Caminho de acesso e destaque para a ferramenta “Raster to 
Multipoint” e as configurações definidas. 

Figura 28. Resultado da criação da camada vetorial tipo “ponto” a partir de um 
raster contendo os valores altimétricos. 

Nessa etapa, o MDE gerado pelo processo “Fill”, chamado de “mde_
UTM_fill”, servirá de base para se gerar uma malha regular de pontos 
altimétricos. Para isso, utilize a ferramenta “Raster to Multipoint”, 
disponível em “3D Analyst Tools > Conversion > From Raster > 
Raster to Multipoint” (Figura 27). Na janela que se abre, em “Input 
Raster”, adicione o “mde_UTM_fill” e então selecione o local para 
salvar no feature data set(Trilhas_WGS84_UTM) e o nome como 
“pontos_3D_multi”. Mantenha as demais configurações como padrão.

Como resultado, será gerada uma camada vetorial do tipo “ponto”, 
onde cada um está situado exatamente no centro da respectiva célula, 
contendo o valor da cota (altitude) na sua tabela de atributos (Figura 
28).
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Entretanto, ao observarmos a tabela de atributos da feição 
“pontos_3D_multi”, constatamos que essa camada vetorial tem todos 
os pontos representados por uma única feição (feição multipontos). 
Assim, torna-se necessário fazer a individualização de cada ponto, para 
que possamos visualizar as informações altimétricas de cada célula. 
Para isso, acesse “Data Management Tools > Features > Multipart 
to Singlepart” (Figura 29). Na janela que se abre, na lista “Input 
Features” selecione “pontos_3D_multi” e salve o resultado com o 
nome “pontos_3D_single”, no conjunto de classes de feições “Trilhas_
WGS84_UTM”.

Figura 29. Caminho de acesso e destaque para a ferramenta “Multipart To 
Singlepart” e as configurações definidas. 

Visualmente, o resultado desse processo não terá qualquer diferença; 
entretanto, ao acessarmos a tabela de atributos dessa nova classe de 
feições, verifica-se que cada ponto estará agora individualizado (Figura 
30).

O próximo passo é obter os valores X, Y e Z (coordenadas e elevação) 
de cada ponto, armazenando-os na sua tabela de atributos. Essas 
informações estão guardadas internamente na feição. Para isso será 
usada a ferramenta “Add Geometry Attributes”, acessada em “Data 
Management Tools > Features > Add Geometry Attributes” (Figura 
31). Adicione na janela aberta a camada “pontos_3D_single” em “Input 
Features” e logo abaixo selecione a opção “POINT_X_Y_Z_M”. As 
demais opções não precisam ser preenchidas.



37Otimização do Traçado de Trilhas para Acesso a Recursos Florestais Naturais

Figura 30. Resultado da individualização dos elementos de uma feição 
multiponto, mostrando a respectiva  tabela de atributos. 

Figura 32. Tabela de atributos com destaque para as coordenadas X, Y e Z 
adicionadas à feição. 

Figura 31. Caminho de acesso e destaque para a ferramenta “Add Geometry 
Attributes” e as configurações definidas. 

Como resultado, na tabela de atributos da camada “pontos_3D_single”, 
serão exibidas as coordenadas (X, Y, Z) de cada ponto individualizado 
(Figura 32).
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Ao visualizarmos a tabela de atributos, há diversos campos contendo 
informações irrelevantes para as etapas subsequentes. A exclusão 
dessas colunas não prejudicará as análises e deixará a tabela mais 
“enxuta”. Para isso acesse “Data Management Tools > Fields > Delete 
Field” e selecione as colunas a serem excluídas, deixando somente os 
campos (colunas), OBJECTID, Shape, POINT_X, POINT_Y e POINT_Z. 
Deve-se tomar cuidado na execução desse processo, pois se for 
deletado qualquer um dos campos citados erroneamente não há a 
possibilidade de se desfazer essa ação.

Geração da rede a partir de uma malha regular de 
pontos altimétricos
No ambiente raster, o deslocamento só é possível entre células 
adjacentes conforme ilustrado na Figura 33. Para replicar essa 
propriedade na estrutura vetorial, cada ponto deverá ser conectado por 
um segmento de reta a cada um dos seus oito pontos vizinhos4. Para 
gerar todas as linhas/grades ligando os pontos adjacentes, mantendo-
-se a informação geográfica de cada ponto, são necessários vários 
processos manuseando a tabela de atributos das feições, tais como a 
criação de colunas e inclusão de novos dados. O primeiro passo será 
identificar os oitos vizinhos mais próximos de cada ponto (Figura 33), 
permitindo traçar a ligação do ponto aos seus vizinhos.

Figura 33. Direção dos oito vizinhos mais 
próximos de um ponto selecionado

4Pontos situados nos limites da área de estudo terão um número menor de vizinhos.
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Para essa etapa será utilizada a ferramenta “Generate Near Table”, 
disponível em “Analysis Tools > Proximity > Generate Near Table”. Na 
janela que se abre, as seguintes informações devem ser preenchidas 
(Figura 34): em “Input Features” adicionar a camada “pontos_3D_
single”; em “Near Features”, novamente a camada “pontos_3D_single”, 
ou seja, irá procurar os pontos mais próximos do próprio conjunto de 
pontos; em “Output Table” indicar o local para salvar, dando-lhe o nome 
“tabela_OD” (OD = origem-destino); em “Search Radius” digitar o valor 
45, que significa o valor em metros do raio máximo para se procurar 
um ponto vizinho. A distância máxima entre duas células adjacentes 
estará associada às células conectadas diagonalmente. Considerando-
-se o valor de 30 m para o tamanho de uma célula deste estudo de 
caso específico, a diagonal entre dois pontos é igual a 42,43 m, i.e., 
30√2, arredondando-se esse valor para 45. Marca-se a opção “Location 
(optional)”, desmarcando “Angle (optional)” e “Find only closest 
feature (optional)”, ou seja, armazenar o identificador e a localização 
(coordenadas X,Y) de todos os vizinhos mais próximos encontrados 
dentro do raio de busca e não somente as informações do vizinho mais 
próximo; em “Maximum number of closest matches (optional)” digitar 
o valor 8, ou seja, encontrar os oitos primeiros pontos; em “Method 
(optional)” mantenha o valor padrão (Planar).

Figura 34. Caminho de acesso e destaque para a ferramenta “Generate Near 
Table” e as configurações definidas. 
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O resultado desse procedimento é uma tabela indicando os oito vizinhos 
mais próximos de cada ponto, com suas respectivas identificações, 
distâncias, ordenamentos de proximidade e coordenadas (Figura 35). 
Cabe destacar que, apesar de se utilizar a mesma camada de pontos 
como origem e destino, cada ponto é desconsiderado no processo de 
se identificar seus vizinhos mais próximos.

Figura 35. Tabela de atributos com a identificação dos oito vizinhos mais 
próximos de cada ponto, em que: IN_FID = numeração do ponto de origem; 
NEAR_FID = numeração do ponto vizinho; NEAR_DIST = distância em metros 
entre os dois pontos; NEAR_RANK = ordenação crescente dos vizinhos 
mais próximos; FROM_X = coordenada X do ponto de origem; FROM_Y = 
coordenada Y do ponto de origem; NEAR_X = coordenada X do ponto vizinho; 
NEAR_Y = coordenada Y do ponto vizinho. 

Em seguida será criado um novo campo/coluna na tabela da Figura 35, 
“tabela_OD”, com o intuito de individualizar e definir uma identificação 
única para cada linha. Para adicionar um novo campo, acione a 
ferramenta disponível em “Data Management Tools > Fields > Add 
Field” (Figura 36). Na janela aberta adicione em “Input Table” a tabela 
“tabela_OD” e atribua o nome de “id_OD” (identidade origem-destino) 
em “Field Name”. Em “Field Type”, selecione “TEXT”, ou seja, tipo do 
campo como texto, e, por último, digite o valor 20 em “Field Length 
(optional)”, significando que este terá um máximo de 20 caracteres. 
Para as demais opções, mantenha o padrão. Ao término desse 
processo, a nova coluna id_OD será inserida à direita na “tabela_OD”, 
conforme se vê na Figura 37.
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Figura 36. Caminho de acesso e destaque para a ferramenta “Add Field” e as 
configurações definidas.

Figura 37. Tabela de atributos com destaque para a nova coluna criada. 

O passo seguinte é povoar o novo campo id_OD da tabela de atributos 
“tabela_OD” com as devidas informações. O objetivo é inserir, em cada 
registro (linha) dessa coluna, o número do ponto de origem e o número 
do ponto de destino, gerando assim uma identificação única para cada 
ligação. Clique com o botão direito do mouse sobre o nome “id_OD” 
na tabela; das opções listadas, selecione “Field Calculator” (Figura 38). 
Na janela que se abre, selecione a opção “String” em “Type” e insira 
a seguinte fórmula: [IN_FID] & “_” & [NEAR_FID]; em que: [IN_FID] 
= ponto de origem; [NEAR_FID] = ponto de destino; & = símbolo 
para concatenação; “_” = caractere escolhido como separador dos 
identificadores Origem e Destino. O resultado é apresentado na Figura 
39.



42
Otimização do Traçado de Trilhas para Acesso a Recursos Florestais Naturais

Figura 38. Caminho de acesso para a ferramenta “Field Calculator...” e 
expressão utilizada para concatenação das informações. 

Figura 39. Resultado da concatenação dos identificadores, com destaque para 
o número do ponto de origem (IN_FID), número do vizinho (NEAR_FID) e a 
concatenação das numerações origem-destino (ID_OD). 

Fonte: ArcGIS 10.3.

Na sequência serão adicionadas as informações da elevação dos 
pontos (coordenada Z), na “tabela_OD”. Para isso, esses valores serão 
importados da tabela de atributos da camada vetorial “pontos_3D_
single”. A ferramenta utilizada será “Join Field”, disponível em “Data 
Management Tools > Joins > Join Field” (Figura 40). Na janela aberta, 
em “Input Table”, selecione a tabela “tabela_OD”; em seguida, em 
“Input Join Field” selecione “IN_FID”, ou seja, o campo-chave para 
união das tabelas; em “Join Table”, selecione “pontos_3D_single”, ou 
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Figura 40. Acesso e destaque para a ferramenta “Join Field” e as configurações 
definidas.

Figura 41. Caminho de acesso e destaque para a ferramenta “Alter Field” e as 
configurações definidas.

seja, buscar essa informação na tabela de atributos dessa classe de 
feições. Em “Output Join Field”, selecione “OBJECTID” e, por último, 
marque a opção “POINT_Z”, para anexar apenas essa informação, que 
é a de interesse.

O próximo passo é alterar o nome da coluna com as informações de 
elevação dos pontos de origem. Para isso acesse a ferramenta “Alter 
Field”, disponível em “Data Management Tools > Fields > Alter Field” 
(Figura 41). Na janela aberta adicione “tabela_OD” em “Input Table”; 
em “Field Name”, selecione o campo que deseja alterar o nome, neste 
caso “POINT_Z”; em “New Field Name (optional)” atribui-se o novo 
nome como “z_O” (informação de elevação para o ponto de origem), e 
marque a opção “Clear Alias”, para que não seja usado apelido para o 
campo. Com isso será alterado o nome da coluna, evitando possíveis 
conflitos e enganos nas próximas etapas (Figura 42).
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Figura 42. Destaque para a alteração do nome da coluna na tabela de atributos 
com a informação da elevação de cada ponto. 

Figura 43. Caminho de acesso e destaque para a ferramenta “Join Field” e as 
configurações definidas para obtenção dos valores de altitude dos pontos de 
destino. 

Deve-se agora repetir os dois últimos processos, visando inserir os 
valores de elevação dos pontos de destino. Novamente, acesse “Data 
Management Tools > Joins > Join Field” (Figura 43). Na janela aberta 
em “Input Join Field” ao invés de “IN_FID” selecione “NEAR_FID”, ou 
seja, o ponto de destino. As demais opções seguem de acordo com o 
processo anterior.

Novamente altera-se o nome da coluna das informações de elevação 
para os pontos de destino: “Data Management Tools > Fields > 
Alter Field”, utilizando os mesmos passos da etapa anterior, apenas 
modificando-se para “z_D” em “Field Name”, ou seja, informação de 
elevação do ponto de destino (Figura 44).
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Figura 44. Acesso e destaque para a ferramenta “Alter Field” e as 
configurações definidas. 

Figura 45. Tabela de atributos com destaque para as colunas com os nomes 
alterados, para a informação da elevação dos pontos de origem (z_O) e destino, 
vizinho(z_D).  

Ao final, na tabela de atributos serão exibidas as informações de 
elevação dos pontos de origem (z_O) e de destino (z_D) (Figura 45).

A próxima etapa será de fato a criação das linhas ou redes ligando os 
pontos de elevação, a partir dos pares de coordenadas origem-destino. 
Para isso será utilizada a ferramenta “X Y To Line”, acessada em 
“Data Management Tools > Features > X Y To Line” (Figura 46). Na 
janela que se abre, as seguintes informações devem ser adicionadas: 
em “Input Table” adicione a tabela “tabela_OD”; em “Output Features 
Class” selecione o local para salvar a camada vetorial de  nome “arco_
OD”, ou seja, as linhas ligando os pontos de altitude da origem para 
o destino; em “Start X Field” e “Start Y Field” selecione “FROM_X” 
e “FROM_Y”, respectivamente, ou seja, indique os campos de X e Y 
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de onde partirão as linhas; em “End X Field” e “End Y Field” selecione 
“NEAR_X” e “NEAR_Y”, respectivamente, ou seja, os pontos finais de 
ligação da linha em X e Y; em “Line Type (optional)” mantenha o padrão 
“GEODESIC”. Em “ID (optional)”, selecione “id_OD” para que essa 
informação seja adicionada no novo arquivo de linha a ser gerado. Por 
último, selecione a referência espacial em “Spatial Reference (optional)” 
de acordo com seu projeto, neste caso “WGS_1984_UTM_Zone_19S”, 
lembrando que deve estar em um sistema de coordenadas planas.

Figura 46. Caminho de acesso e destaque para a ferramenta “X Y To Line” e as 
configurações definidas. 

Figura 47. Rede interligando os pontos, contendo as informações dos pontos de 
origem e destino de cada segmento de linha.  

Como resultado é criada uma feição vetorial do tipo linha para cada 
registro da tabela “tabela_OD”, sendo possível a visualização da rede 
interligando os pontos, quais pontos se ligam a um determinado ponto, 
a distância entre eles e suas coordenadas (Figura 47).
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Figura 48. Acesso e destaque para a ferramenta “Delete Identical” e as 
configurações definidas.  

Figura 49. Destaque para a redução pela metade da quantidade de dados, após 
remoção de dados duplicados de origem e destino.  

Observa-se, na tabela (Figura 47), que são criadas linhas de “ida” e de 
“volta” do ponto de origem para o destino. Porém, essa informação 
de “volta” apenas duplica os dados (caminho 1_2 é igual ao 2_1), não 
tendo utilidade nesse caso. Dessa maneira, esses dados devem ser 
deletados por meio da ferramenta “Delete Identical”, disponível em 
“Data Management Tools > General > Delete Identical” (Figura 48). Na 
janela que é aberta, selecione o arquivo “arco_OD” em “Input Dataset” 
e, em seguida, selecione a opção “Shape” em “Field(s)”. Para as 
demais opções, mantenha o padrão.

Observando-se o número de registros da tabela de atributos (Figura 
49), percebe-se que a quantidade de linhas ou informações é reduzida 
exatamente pela metade, devido à exclusão dos dados replicados.
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Indexando informações de camadas vetoriais
As feições vetoriais tipo linha da camada “arco_OD”, criada pela 
ferramenta “XY To Line” (Figura 49),  não possuem informações acerca 
dos valores de elevação dos “nós” associados às suas extremidades 
(origem e destino). Essa informação, que está disponível na tabela 
“tabela_OD” (Figura 35), é imprescindível para se calcular a inclinação 
do respectivo segmento. A seguir, descreve-se o procedimento para 
incorporar os valores das elevações dos “nós” origem e destino de cada 
arco, na respectiva tabela de atributos de “arco_OD”. 

Inicialmente é necessário criar novas colunas para a importação dos 
dados. Para tanto, usa-se a ferramenta “Add Field”; porém, para maior 
agilidade e para demonstrar uma segunda opção para criação de um 
campo, essa operação será realizada diretamente na tabela de atributos. 
Abra a tabela de atributos da camada “arco_OD”, e na barra de 
ferramentas superior, clique em “Table Options > Add field...” (Figura 
50). Na janela que se abre, digite “z_O” como nome do novo campo. 
Esse campo receberá os valores da elevação dos pontos de origem. 
Depois, selecione a opção “Double” em “Type”, que proporciona maior 
precisão para armazenar valores reais.

Figura 50. Rede interligando os 
pontos, contendo a criação de um 
novo campo/coluna (“z_O”) usando os 
recursos disponíveis na interface para 
visualização de tabelas. 

Repita esse processo para criar um novo campo com o nome de “z_D”, 
que receberá a informação da elevação dos pontos de destino (Figura 
51).
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Figura 51. Criação de um novo campo/
coluna (“z_D”) por meio da tabela de 
atributos da feição. 

Figura 52. Tabela de atributos com 
destaque para os dois novos campos/
coluna criados. 

Ao final desse processo, os dois novos campos criados possuirão 
valores nulos para todos os registros da tabela (Figura 52).

O próximo passo será adicionar um índice de atributo na tabela “tabela_
OD”. Esse índice será importante para acelerar a identificação dos 
registros que satisfazem a uma consulta por atributos. Será utilizada 
a ferramenta “Add Attribute Index”, disponível em “Data Management 
Tools > Indexes > Add Attribute Index” (Figura 53). Na janela aberta, 
em “Input Table” selecione “arco_OD” e, em “Fields to Index”, marque 
o campo “id_OD”. Em “Index Name (optional)” digite “id_OD_index” e 
marque a opção “Unique (optional)”, para indicar que inexistem valores 
repetidos para esse atributo. Esse processo ocorre internamente, 
portanto, visualmente, não haverá diferença alguma. Para verificar se 
a criação do índice foi bem-sucedida, basta abrir a tabela de atributos 
e visualizar o campo “id_OD”, que deverá exibir o símbolo “*” após o 
nome no cabeçalho.
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Figura 53. Caminho de acesso e destaque para a ferramenta “Add Attribute 
Index” e as configurações definidas para a tabela “arco_OD”.

Figura 54. Caminho de acesso e destaque para a ferramenta “Add Attribute 
Index” e as configurações definidas para a tabela “tabela_OD”.

Repita esse procedimento para a tabela “tabela_OD”; as demais 
informações se mantêm exatamente como na etapa anterior (Figura 
54).

Pode-se agora fazer a união temporária entre as tabelas de atributos de 
“arco_OD” e “tabela_OD”. Para isso será utilizada a ferramenta “Joins 
and Relates”. Para acessá-la, no painel à esquerda da janela do ArcMap 
(Table of Contents), posicione o cursor sobre o nome da camada “arco_
OD” e clique o botão direito do mouse. Na lista de opções, selecione 
“Joins and Relates > Join...” (Figura 55). Na janela que se abre, 
selecione “Join attributes from a table” para efetuar uma união baseada 
somente nos valores do atributo selecionado; no campo “1”, selecione 
o atributo “id_OD”, que será então usado como campo-chave para 
estabelecer as conexões entre os registros das tabelas; no campo “2”, 
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Figura 55. Caminho de acesso e destaque para a ferramenta “Join...” e as 
configurações definidas. 

selecione “tabela_OD”, cujos registros serão pareados com os da tabela 
de atributos de “arco_OD”; no campo “3”, selecione o campo “id_OD” 
da tabela “tabela_OD”; deixe as demais informações da forma em que 
se encontram. Finalmente clique em Ok para efetuar a união das duas 
tabelas.

Ao abrir a tabela de atributos da camada “arco_OD”, percebe-se que 
todas as informações da tabela “tabela_OD” são exibidas à direita 
da sua última coluna original, i.e., z_D. Pode-se agora copiar os 
valores de elevação para os campos apropriados. Para isso, coloque 
a feição “arco_OD” no modo de edição (“Editor>start editing”); em 
seguida,  abra a tabela de atributos dessa feição, posicione o cursor 
sobre o nome da coluna “z_O” e clique com o botão direito do mouse 
e selecione “Field Calculator” (Figura 56). Na janela que se abre, no 
painel “Fields”, escolha a opção “tabela_OD.z_O” com um clique duplo. 
Esse campo será adicionado no painel inferior, indicando que a coluna 
“z_O” da tabela de atributos de “arco_OD” será preenchida com os 
respectivos valores do campo z_O da tabela “tabela_OD”.

Repita o mesmo processo para o campo “z_D”; selecionando “tabela_
OD.z_D” na calculadora de campo (Figura 57).
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Figura 56. Acesso e destaque para a ferramenta “Field Calculator...” e 
expressão utilizada para copiar os valores da altitude dos pontos de origem. 

Figura 57. Acesso e destaque para a ferramenta “Field Calculator...” e 
expressão utilizada para copiar os valores de altitudes dos pontos de destino. 

Após esses procedimentos, bastará desfazer a união temporária, na 
própria tabela de atributos, clicando na opção “Table Options > Joins 
e Relates > Remove Join(s) > Remove all joins” e finalizar o modo de 
edição da feição “arco_OD”, clicando em “Stop Editing”, salvando as 
alterações.

Transformação de feição 2D em objeto 3D
Depois de finalizada a preparação da camada “arco_OD”, é necessário 
que a informação da elevação ou altitude fique associada internamente 
a cada uma de suas extremidades, passando assim a ser parte 
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Figura 58. Caminho de acesso e destaque para a ferramenta “Interpolate 
Shape” e as configurações definidas. 

integrante de cada feição. Para isso será utilizada a ferramenta 
“Interpolate Shape”, disponível em “3D Analyst Tools > Functional 
Surface > Interpolate Shape” (Figura 58). Na janela aberta, em “Input 
Surface” adicione o MDE criado no processo “Fill”, i.e., “mde_UTM_
fill”; em “Input Feature Class” selecione a camada “arco_OD” e, em 
“Output Feature Class”, aponte o local para salvar a camada resultante, 
nomeando-a “arco_OD_3D”. Marque a opção “Interpolate Vertices Only 
(optional)” e deixe as demais opções inalteradas. Com esse processo, 
as feições são convertidas para feições espaciais do tipo linha 3D.

Comprimento real de um arco
A distância calculada entre dois pontos alinhados na direção Norte-
Sul ou Leste-Oeste é de 30 m; já para pontos alinhados na direção 
Nordeste-Sudoeste ou Noroeste-Sudeste, a distância é igual a 42,43 
m, i.e., 30√2. Entretanto, isso só é válido se ambos os pontos tiverem 
a mesma altitude. Se houver diferença de altitude entre os pontos, a 
distância real será maior. Essa distância real ou tridimensional entre 
os pontos pode ser calculada pela distância euclidiana, aplicando-se o 
teorema de Pitágoras (Figura 59).

Será utilizada a ferramenta “Add Field” para a criação de um campo que 
represente a distância real, tridimensional. Novamente, com a tabela de 
atributos da feição “arco_OD_3D” aberta, vá até a barra de ferramentas 
superior em “Table Options > Add field...” (Figura 60). Na janela que 
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se abre atribua o nome “dist_OD_3D”, para armazenar a distância real 
tridimensional entre os pontos de origem e destino; depois selecione a 
opção “Double” em “Type”.

Figura 59. Aplicação do teorema de Pitágoras, em que: Distância 3D = 
distância real a ser calculada; z_O = altitude do ponto de origem; z_D = 
altitude do ponto de destino; H = diferença absoluta de altitude entre os 
pontos de destino e origem; Shape length = distância horizontal (projetada) 
entre os pontos de origem e destino.

Figura 60. Criação de um novo campo/coluna (“dist_OD_3D”) pela interface da 
tabela de atributos da classe de feições.

A próxima etapa será o cálculo dos respectivos valores para esse 
novo campo. Para isso, com a tabela de atributos de “arco_OD_3D” 
aberta, posicione o cursor no nome da coluna “dist_OD_3D”, clique 
com o botão direito do mouse e selecione a opção “Field Calculator” 
(Figura 61). Na janela que se abre, selecione a opção “Python” em 
“Parser” para trabalhar com a linguagem Phyton. Depois, posicione o 
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Figura 61. Caminho de acesso e destaque para a ferramenta “Field 
Calculator...” e expressão utilizada para calcular a distância real ou 
tridimensional entre dois pontos em diferentes cotas. 

Figura 62. Tabela de atributos da feição “arco_
OD_3D” destacando-se a diferença entre as 
distâncias projetadas e real. 

cursor dentro do painel inferior e adicione a seguinte expressão: “math.
sqrt(math.pow( !Shape_Length!, 2 ) + math.pow(math.fabs( !Z_D! - 
!Z_O! ), 2 ) )”, que equivale a √(Shape length^2+|z_D-z_O|^2 ). A 
seguir, clique no botão OK para executar a expressão para todos os 
registros da tabela de atributos.

Ao visualizar a tabela de atributos atualizada, percebe-se que a 
distância 3D, de fato, difere da distância horizontal quando as 
extremidades do arco não estão na mesma altitude (Figura 62).

Vários campos ou colunas presentes na tabela de atributos não serão 
necessários em nenhum momento; portanto, a exclusão dessas colunas 
pode ser feita sem prejuízo, facilitando bastante a visualização dos 
campos e dos respectivos valores. Vá em “Data Management Tools > 
Fields > Delete Field” (Figura 63). Com a janela aberta, selecione a 
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opção “arco_OD_3D” na lista “Input Table” e marque no painel “Drop 
Field” os campos “FROM_X”, “FROM_Y”, “NEAR_X” e “NEAR_Y”. A 
exclusão de dados desnecessários é importante também para melhorar 
e otimizar o desempenho do software, pois essas informações ocupam 
memória e espaço em disco durante os processamentos.

Figura 63. Caminho de acesso e destaque para a ferramenta “Delete Field...” e 
as configurações definidas. 

Declividade de um arco
Nesta etapa será calculada a declividade de cada arco, ou seja, a 
inclinação do segmento de reta conectando os pontos de origem e 
destino. Essa informação será utilizada mais adiante para calcular a 
velocidade de deslocamento no terreno. Novamente, deve-se criar 
novos campos na tabela de atributos da classe de feições “arco_
OD_3D” para receber tais valores. Siga o procedimento já efetuado 
para criação de uma nova coluna/campo. Com a tabela de atributos da 
classe de feições “arco_OD_3D” aberta vá até a barra de ferramentas 
superior em “Table Options > Add field...” (Figura 64). Com a janela 
aberta atribua o nome “incl_dec_OD”, ou seja, a inclinação em graus 
decimais da origem para o destino; depois selecione a opção “Double” 
em “Type” para maior precisão.

Em seguida, adicione um novo campo, nomeando-o “incl_dec_DO”, 
para receber os valores da inclinação, em decimais, do destino para 
a origem, i.e., no sentido inverso (Figura 65). Esses resultados serão 
utilizados nos próximos passos do cálculo da velocidade, uma vez que a 
velocidade para se percorrer um trecho em aclive poderá diferir daquela 
para se percorrer o mesmo trecho morro abaixo.
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Figura 66. Fórmula para o cálculo da inclinação entre dois pontos expressa em 
graus decimais.

Figura 64. Criação de um novo campo/
coluna (“incl_dec_OD”) por meio da 
tabela de atributos da feição.

Figura 65. Criação de um novo campo/
coluna (“incl_dec_DO”) por meio da 
tabela de atributos da feição. 

Os campos criados serão preenchidos com os resultados do cálculo das 
inclinações da rampa nos dois sentidos. A inclinação da rampa é dada 
pela tangente do ângulo entre um plano horizontal e o segmento unindo 
os pontos origem e destino ou destino e origem (Figura 66).
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Com a tabela de atributos da classe de feições “arco_OD_3D” aberta, 
vá primeiro até o campo “incl_dec_OD”, clique com o botão direito 
do mouse sobre o nome e selecione “Field Calculator” (Figura 67). No 
painel inferior dessa janela, adicione a seguinte expressão “( [z_D]- 
[z_O] ) / [Shape_Length]”.

Figura 67. Acesso e destaque para a ferramenta “Field Calculator...” e a 
expressão utilizada para calcular a inclinação entre origem e destino. 

Figura 68. Acesso e destaque para a ferramenta “Field Calculator...” e 
expressão utilizada para calcular a inclinação no sentido destino-origem. 

Agora faça o mesmo para preencher o campo “incl_dec_DO”. Use 
a mesma expressão, apenas invertendo a posição do “z_D” e “z_O” 
por se tratar do caminho inverso, inserindo ([z_O-zD])/[shape_length], 
(Figura 68).
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Ao final, a inclinação em valores decimais será calculada e exibida para 
ambos os sentidos de se percorrer cada arco, ou seja, origem-destino e 
destino-origem, sendo as respectivas inclinações exatamente o inverso 
aditivo uma da outra (Figura 69).

Figura 69. Tabela de atributos da 
classe de feições “arco_OD_3D” com 
destaque para as inclinações dos 
percursos nos sentidos origem-destino 
e destino-origem. 

Velocidade de Tobler
No presente estudo, a inclinação do relevo (declive ou aclive) afeta 
diretamente a velocidade humana para percorrer caminhos declivosos. 
Para se estimar a velocidade de caminhada em função da inclinação 
do percurso, será adotada a função de Tobler (TOBLER, 1993), assim 
definida:

W=6e-3,5| +0.05 |dx
dh

dh =S=tanθdx
Em que: 
W = velocidade de caminhada (km/h)
S = inclinação da rampa
dh = diferença de elevação entre os pontos extremos da rampa
dx = distância horizontal em linha reta entre os extremos da rampa
θ = ângulo entre as extremidades da rampa.

A regra de Tobler é uma função exponencial para determinação da 
velocidade de caminhada, levando em conta o ângulo de inclinação do 
terreno, seja por aclive ou declive (SÁSKA; DOMBAY, 2012; HERZOG, 
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2010; TOBLER, 1993) (Figura 70). Para terrenos planos, i.e., dh = 0, a 
velocidade de caminhada é igual a 5,05 km/h. A velocidade máxima de 
caminhada é atingida para percursos com declive de aproximadamente 
-5%.

Figura 70. Função exponencial da velocidade caminhada de Tobler, de acordo 
com declividade do terreno.

Assim, o tempo para se percorrer um segmento, em cada um dos 
sentidos (aclive e declive), será calculado aplicando a função de 
Tobler, armazenando-se os respectivos valores na tabela de atributos. 
Para isso, com a ferramenta “Add Field ”adicione dois novos campos 
à tabela de atributos da classe de feições “arco_OD_3D”, com os 
nomes de “tobler_hr_OD” (Figura 71) e “tobler_hr_DO” (Figura 72), 
selecionando a opção “Double” para o tipo de dados (Type).

Figura 71. Criação de um novo campo/
coluna (“tobler_hr_OD”) por meio da 
interface da tabela de atributos. 



61Otimização do Traçado de Trilhas para Acesso a Recursos Florestais Naturais

Figura 73. – Caminho de acesso e destaque para a ferramenta “Field 
Calculator...” e expressão utilizada para calcular o tempo de caminhada entre 
destino e origem, aplicando-se a regra de Tobler. 

Figura 72. Criação de um novo 
campo/coluna (“tobler_hr_DO”), 
utilizando a funcionalidade disponível 
na interface para visualização de 
tabelas de atributos. 

O próximo passo será abrir a calculadora de campo (“Field Calculator”) 
para calcular as velocidades de caminhada para cada sentido de um 
arco. Clique com o botão direito do mouse na coluna “tobler_hr_OD”; 
selecione “Field Calculator” e, na janela que se abre, insira a fórmula de 
Tobler da seguinte maneira, no painel inferior: “[dist_OD_3D] / (6000.0 
* Exp ( -3.5 * Abs ( [incl_dec_OD] + 0.05 ) ) )” (Figura 73). O valor 
6000 na expressão é para a conversão do resultado em metros/hora. 
A divisão do tamanho real do segmento pela velocidade de caminhada 
correspondente, ou seja, (6000e-3,5|dh/dx+0.05|), é que fornecerá o tempo 
em horas para percorrer cada segmento.
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Repita esse procedimento para o campo “tobler_hr_DO”, modificando a 
respectiva inclinação “incl_dec_DO” na expressão (Figura 74). A Figura 
75 mostra o resultado dessas operações.

Figura 74. Caminho de acesso e destaque para a ferramenta “Field 
Calculator...” e expressão utilizada para calcular o tempo de caminhada entre 
origem e destino, aplicando-se a função de Tobler. 

Figura 75. Tabela de atributos da classe 
de feições “arco_OD_3D”, com destaque 
para os tempos de caminhada, estimados 
para os percursos origem-destino e 
destino-origem, segundo a regra de 
Tobler.

Pode-se perceber, nas áreas com relevo mais íngreme, 
proporcionalmente um maior tempo para se percorrer os segmentos 
(Figura 76). Para converter o tempo de caminhada em minutos, basta 
multiplicar o valor de Tobler por 60. Por ser a área desse exemplo 
pouco declivosa, a amplitude de tempo mínimo e máximo para percorrer 
cada segmento não foi grande.
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Figura 76. Amplitude de tempos de caminhada em função da inclinação do 
terreno. 

Barreiras relativas e absolutas
A inclinação do terreno é o principal custo a ser considerado para 
otimização de um caminho ou traçado de acesso a determinado 
recurso. Entretanto, como o propósito da metodologia aqui apresentada 
é a aplicação em ambientes de florestas naturais, sabe-se que há 
muitos outros fatores determinantes que servem como impedância 
para o caminhamento ou traçado. Assim, sempre que possível, deve-
-se considerar esses obstáculos na metodologia, representando mais 
fielmente o ambiente florestal modelado.

Identificam-se dois tipos de barreiras: aquelas em que não se deve 
de forma alguma cruzá-las (ultrapassá-las), chamadas de barreiras 
absolutas, e aquelas em que se deve evitar cruzar por representarem 
um atraso no caminhamento, denominadas barreiras relativas. A 
identificação dessas barreiras pode ser registrada por meio de coleta de 
dados em campo, variando de acordo com os objetivos do trabalho e as 
percepções obtidas da área de estudo. Dentre essas barreiras, a mais 
importante, e que será considerada como exemplo nesse minucioso 
roteiro, é a rede hidrográfica dentro do local de estudo. A hidrografia 
é importante na definição do traçado; qualquer local de estudo é 



64
Otimização do Traçado de Trilhas para Acesso a Recursos Florestais Naturais

cortado por rios e igarapés, os quais representam resistências físicas 
ao traçado das trilhas. Desta forma, pode-se restringir a transposição 
de corpos d’água, ou apenas incluir suas superfícies como um fator de 
impedância, podendo ser cruzadas  quando não houver outra alternativa 
ou, ainda, locomover-se pela hidrografia utilizando um barco.

Para exemplificar, será utilizada a rede hidrográfica raster modelada no 
início deste estudo, depois de ser ordenada pelo método de Shreve. 
O primeiro passo será a vetorização dessa feição. Para tal, utiliza-se 
a ferramenta “Raster to Polyline” disponível em “Conversion Tools 
> From Raster > Raster to Polyline” (Figura 77). Na janela aberta, 
em “Input Raster”, adicione a hidrografia raster e selecione o local 
para salvar, atribuindo-lhe o nome “hidro_shreve_v”, i.e., hidrografia 
ordenada pelo método Shreve, no formato vetorial. Em seguida, em 
“Background value (optional)” selecione “NODATA”, ou seja, todas 
as demais células desse grid estão assinaladas com “NODATA”. Por 
último, desmarque a opção “Simplify Polylines”, para seguir exatamente 
o traçado centro a centro das células. Ao final do processamento será 
gerada uma nova classe de feições vetoriais do tipo linha.

Figura 77. Caminho de acesso e destaque para a ferramenta “Raster to 
Polyline” e as configurações definidas. 

Novamente, pode-se apagar os campos desnecessários da tabela de 
atributos. Com a ferramenta “Delete Field”, delete os campos “arcid”, 
“from_node” e “to_node” (Figura 78).
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Figura 78. Caminho de acesso e destaque para a ferramenta “Delete Field” e as 
configurações definidas. 

Figura 79. Caminho de acesso e destaque para a ferramenta “Alter Field” e as 
configurações definidas. 

Para melhor organização da informação, deve-se renomear a coluna 
“grid_code” para “shreve”, pois essa coluna contém a informação do 
ordenamento obtida a partir do raster. Para isso acesse a ferramenta 
“Alter Field” disponível em “Data Management Tools > Fields > 
Alter Field” (Figura 79). Na janela aberta selecione a classe de feições 
“hidro_shreve_v” na lista “Input Table”; em “Field Name”, marque o 
campo “grid_code” para ser renomeado e, logo abaixo, digite o novo 
nome, “shreve”.

O próximo passo será identificar os segmentos interceptados pelos 
arcos da hidrografia, que representarão regiões com impedâncias 
bastante distintas daquelas atribuídas ao relevo. Para assegurar a 
seleção de todos os arcos interceptados pela rede hidrográfica, será 
gerada uma faixa com largura igual a 1/10 do lado de uma célula, ou 
seja, 3 m, de cada lado da rede hidrográfica. Os polígonos resultantes 
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serão armazenados em uma nova classe de feições denominada “hidro_
larg”. Isso será feito mediante o uso da ferramenta “Buffer”, disponível 
em “Analysis Tools > Proximity >Buffer” (Figura 80). Na janela aberta: 
(1) na lista “Input Features” selecione a camada “hidro_shreve_v”; 
em “Output Feature Class” selecione o local para salvar a classe de 
feições resultante e atribua-lhe o nome “hidro_larg”; em “Distance 
[value or field]” clique no campo logo abaixo da opção “Linear unit” 
e digite o valor 3; em “Dissolve Type (optional)” selecione “ALL”, o 
que significa dissolver todos os buffers gerados ao longo de cada arco 
da hidrografia, resultando uma única feição do tipo polígono (2). Para 
todas as demais opções da ferramenta “Buffer”, mantenha os valores 
originalmente assinalados.

Figura 80. Caminho de acesso e destaque para a ferramenta “Buffer”, com  as 
configurações definidas (1), e a classe de feição resultante (2).

É oportuno relembrar que os arcos da hidrografia vetorial “arco_OD_3D” 
passam exatamente sobre o centro das respectivas células da versão 
raster da malha hidrográfica, conforme ilustrado na Figura 81. Uma vez 
que as células da hidrografia têm o mesmo tamanho que as do MDE e 
que esses dois grids se alinham perfeitamente, os arcos selecionados 
representam regiões do relevo ocupadas por água.
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Figura 82. Caminho de acesso, destacando-se a ferramenta “Select By 
Location...” e as respectivas configurações definidas. 

Figura 81. Sobreposição dos arcos da hidrografia 
vetorial com os pontos associados aos centros 
das células e alinhamento dos grids hidrografia 
raster e MDE. 

Na sequência serão selecionados os arcos ou segmentos que 
interceptam a rede hidrográfica, visando definir de que forma essa 
barreira será representada na simulação do traçado das trilhas. No 
menu principal do ArcMap, localizado na parte superior da sua janela, 
clique em “Selection” e escolha a opção “Select By Location...” 
(Figura 82). Na janela que se abre, clique em “Selection method” e 
selecione a opção “select features from”. A seguir, marque a camada 
“arco_OD_3D” no painel “Target layer (s)”; clique na lista “Source 
layer” e selecione a camada “hidro_larg”. Certifique-se de que a opção 
“intersect the source layer feature” esteja selecionada para o campo 
“Spatial selection method for target layer feature(s):”. Por fim, clique no 
botão OK para executar a seleção espacial.
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Com esse comando serão selecionadas todas as feições da camada 
“arco_OD_3D” que intersectam o polígono de “hidro_larg” (Figura 83).

Figura 83. Arcos da classe de feições “arco_OD_3D” que intersectam a rede 
hidrográfica. 

Aqui é assumido que percorrer uma célula da hidrografia leva o dobro 
do tempo de percorrer uma célula do terreno. Essa informação deverá 
ser atualizada somente para os arcos selecionados. Assim, abra a 
tabela de atributos da camada “arco_OD_3D”. Em seguida, posicione 
o cursor sobre o nome da coluna “tobler_hr_OD”, clique com o botão 
direito do mouse e abra a calculadora de campo (“Field Calculator”). No 
painel inferior, crie a expressão “[tobler_hr_OD] * 2” (Figura 84). Repita 
esse processo para atualizar os valores do campo “tobler_hr_DO”, que 
representarão o tempo de percurso no sentido inverso, i.e., destino-
origem (Figura 85).

Note que, para esse exemplo, a hidrografia foi considerada como uma 
barreira relativa, havendo um custo maior (o dobro do tempo) para se 
cruzá-la. Para estabelecer uma barreira absoluta, bastará impor um 
custo extremamente elevado, fazendo com que o traçado não passe 
por esses trechos ou, ainda, simplesmente editar e deletar as feições 
que representam barreiras absolutas.
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Figura 84. Caminho de acesso, destacando-se a ferramenta “Field Calculator...” 
e a redefinição do tempo gasto para percorrer os segmentos interceptados pela 
hidrografia no sentido origem-destino.

Figura 85. Caminho de acesso, destacando-se a ferramenta “Field Calculator...” 
e a redefinição do tempo gasto para o percurso dos segmentos interceptados 
pela hidrografia no sentido destino-origem.

Esse é apenas um exemplo da abordagem que poderá ser empregada 
para se estabelecer impedâncias (custos) diferenciados, de acordo com 
as características do terreno. Para tornar o exemplo mais próximo da 
realidade, pode-se simular a largura dos rios a partir da ordem de cada 
segmento, pressupondo que quanto maior for o número de afluentes de 
um dado segmento da rede hidrográfica maior será sua largura. Além 
do mais, para rios navegáveis, pode-se assinalar uma velocidade maior 
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ao considerar o tráfego fluvial, devendo-se, porém, adicionar o tempo 
gasto na transição de modais, i.e., para se colocar e retirar a carga do 
barco. Há, ainda, um problema adicional a ser resolvido quando se lida 
com transportes multimodais: a localização e o número ideais de pontos 
de transbordo (atracadouros). Como se pode depreender, existem 
infinitas possibilidades para se modelar apropriadamente um problema 
de transporte, em que a abordagem correta dependerá dos dados 
disponíveis para a área de estudo e, sobretudo, do grau de familiaridade 
do pesquisador com essa classe de problemas e com os recursos 
avançados de modelagem espacial em ambiente SIG.

Ferramentas de análise de redes

No contexto da programação matemática, o termo modelo de redes 
é usado para definir uma classe ampla de técnicas úteis para resolver 
uma grande quantidade de problemas que lidam com a geometria 
de posição, podendo essa posição ser tanto física quanto temporal. 
Algoritmos para a resolução de problemas com estrutura de rede 
antecedem o surgimento da programação linear em cerca de 200 
anos. Os modelos de redes podem todos ser caracterizados como 
tipos especiais de problemas de programação linear. Esses modelos 
são, contudo, resolvidos mais eficientemente utilizando-se algoritmos 
especialmente desenvolvidos para situações específicas, que se 
beneficiam das suas estruturas geométricas mais simples. Há um 
conjunto de características comuns a todos os modelos de redes, que 
permitem que eles sejam formulados e analisados simbolicamente, 
sem que se tenha, sequer, que representar fielmente as localizações 
absolutas das origens e destinos ou mesmo o traçado real das rotas 
conectando tais pontos (RIBEIRO, 2016). A modelagem em redes 
adota uma estrutura de representação especial extremamente versátil 
e funcional, denominada grafo. A seguir, apresentam-se as definições 
clássicas das estruturas elementares utilizadas na modelagem de redes.



71Otimização do Traçado de Trilhas para Acesso a Recursos Florestais Naturais

Terminologia
•	 Grafo: consiste de uma série de junções, denominadas nós, 

que estão conectadas por arcos. No contexto da programação 
matemática, arcos desempenham o papel de variáveis de decisão.

•	 Rede: é um grafo para o qual existe alguma quantidade (distância, 
custo, tempo, relação de hereditariedade, taxa ou capacidade de 
fluxo etc...) associada a cada um de seus arcos.

•	 Cadeia: é uma sequência de arcos conectando nós. Quando se 
especifica a direção do percurso (ou do fluxo) ao longo da cadeia, 
essa cadeia é então referida como caminho ou rota.

•	 Ciclo: é uma cadeia conectando uma rota a ela mesma, ou seja, os 
nós inicial e final são os mesmos.

•	 Grafo conectado: é um grafo no qual há uma cadeia conectando 
cada par de nós.

•	 Árvore: é um grafo conectado, ou rede, sem a ocorrência de ciclos.

•	 Arco orientado (ou direcionado): é aquele para o qual existe um 
senso de direção associado, de tal forma que um nó é considerado 
a origem do arco e o outro, o destino. Assim, pode existir dois 
arcos orientados unindo um único par de nós: um no sentido oposto 
do outro.

•	 Grafo orientado ou rede direcionada: é um grafo no qual todos os 
seus arcos são orientados.

A tecnologia SIG oferece uma solução prática para o problema de 
rotas otimizadas, apresentando vantagens significativas e muito 
interessantes. Neste contexto, destaca-se o software ArcGIS com suas 
extensões, em especial a “Network Analyst”.

A extensão “Network Analyst” fornece um amplo leque de recursos 
para análise espacial, baseados em estruturas vetoriais de rede, 
voltadas à modelagem e resolução de problemas clássicos de 
roteamento, como, por exemplo, instalações mais próximas, 
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identificação da melhor rota, otimização e alocação de recursos, 
instruções pormenorizadas de percursos em áreas urbanas, áreas 
de influências e de atendimento, matriz de custo origem-destino 
(ANTUNES, 2008; ESRI, 2016). Dentre as várias possibilidades de 
aplicação do Network Analyst, maior ênfase será dada a exemplos de 
uso das ferramentas para a resolução de rotas entre origem-destino 
e o problema clássico do Caixeiro Viajante, para obtenção de trilhas 
otimizadas, tendo em vista a proposta de aplicação dessa metodologia 
na exploração de recursos florestais naturais.

Vale destacar que o algoritmo Dijkstra é a base da implementação 
das ferramentas disponíveis no “Network Analyst” para solução de 
problemas em análise de rede (ESRI, 2016). O algoritmo funciona com 
custos associados aos arcos ou arestas, envolvendo problemas de 
localização em redes com origens e destinos (FERNANDES, 2013). As 
arestas ou arcos representam a ligação entre dois pontos de interesse, 
que são os nós da rede.

Como exemplo prático, deseja-se ir do ponto “1” para o ponto “5” 
pelo melhor caminho, considerando os valores como custos para os 
caminhos, que também podem ser interpretados como o desejo de ir 
de uma cidade a outra. Nesse algoritmo é escolhido um vértice como 
raiz (origem) da busca e, a partir dele, calcula-se o custo mínimo desse 
vértice para todos os demais vértices, até a quantificação de todos os 
custos dos possíveis caminhos, chegando a uma solução ótima com a 
sequência “1-3-6-5” (Figura 86). 

Figura 86. Exemplo hipotético de uma rede 
de estradas com as respectivas distâncias, 
conectando 6 cidades, e apresentação da 
rota de menor custo partindo do ponto 1 e 
chegando ao 5.
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Figura 87. Caminho de acesso e destaque 
para a criação de um novo conjunto de 
dados em rede (“Network Dataset...”) 
dentro de um conjunto de classes de 
feições.

Criação de uma rede 
Para o uso dos recursos disponíveis na extensão “Network Analyst”, 
é necessário criar uma classe de feições especial, denominada de 
conjunto de dados em rede. A criação dessa estrutura somente poderá 
ser feita a partir de uma ou mais classes de feições armazenadas 
necessariamente em um conjunto de classes de feições, i.e., não se 
pode criar uma rede a partir de uma classe de feições armazenada na 
raiz de uma Geobase.

Na barra de ferramentas padrão do ArcMap, clique no ícone Catalog. 
Na janela Catalog, expanda a visualização da árvore de estruturas da 
Geobase “Trilhas”; em seguida, expanda o conjunto de classes de 
feições “Trilhas_WGS84_UTM”. Clique com o botão direito do mouse 
sobre o nome desse conjunto de classes de feições e selecione “New 
> Network Dataset...” (Figura 87).

Uma nova janela é aberta, para criação da rede propriamente dita, 
conforme apresentado a seguir:

a) Em “Enter a name for your network dataset” digite um nome para 
a rede que, neste caso, será “Trilhas_rede”. A opção logo abaixo 
permite definir em qual versão da extensão “Network Analyst” se 
deseja criar a rede, por questões de incompatibilidade entre versões 
distintas. Neste estudo será mantida a versão mais recente, que é a 
10.1 (Figura 88). Depois, clique em “Avançar >”.
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b)	 Deve-se selecionar a(s) classe(s) de feições que fará(ão) parte da 
rede. Neste caso será marcada apenas a classe de feições “arco_
OD_3D” (Figura 89). Em seguida clique em “Avançar >”.

Figura 88. Atribuição do nome e 
versão do formato para o novo 
conjunto de rede. 

Figura 89. Seleção da classe de 
feições utilizada para se criar uma 
rede. 

c)	 A configuração que aparece a seguir é genérica, possibilitando 
contemplar variados níveis de complexidade, como, por exemplo, 
problemas de logística de transporte. Selecione a opção “No” e 
clique em “Avançar >”.
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Figura 90. Adição de um novo 
atributo de custo (“Tempo_tobler”) 
à rede. 

d)	 Essa opção serve para a configuração quando se tem diferentes 
opções de conectividade entre os arcos da rede, o que não é o 
presente caso. Portanto, apenas clique em “Avançar >”.

e)	 Essa etapa serve para configurar conexões ou cruzamentos de 
arcos com alturas diferentes, as coordenadas Z (altitude). É utilizada 
quando se trabalha com dados contendo viadutos, pontes, estações 
de mudança de modal de transporte etc. Neste exemplo, como a 
base do cálculo para o caminho ótimo será o tempo de caminhada 
em cada arco, cujos valores já se encontram na respectiva tabela de 
atributos, selecione a opção “None” e clique em “Avançar >”.

f)	 Essa etapa é a mais importante. A partir dela poderão ser 
atribuídos inúmeros custos para os arcos da rede. Por padrão, o 
custo interpretado pelo software é o comprimento (“Length”) do 
segmento vetorial, que já está adicionado como custo (Figura 90). 
Na sequência  adiciona-se o custo calculado relativo ao tempo de 
caminhada, que foi obtido a partir da velocidade de Tobler. Para isso, 
clique na opção “Add...” e configure a janela aberta da seguinte 
forma: em “Name”, atribua o nome “Tempo_tobler”; em “Usage 
Type” selecione “Cost”, ou seja, será entendido como um custo; 
em “Units” selecione “Hours”, ou seja, unidade em horas; em “Data 
Type” selecione “Double”, implicando maior precisão. Depois clique 
em OK. Um novo campo é adicionado à lista de atributos da rede.
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Note que aparecerá um sinal de exclamação (!) à esquerda da linha 
do novo atributo, indicando que ainda é necessário configurá-lo. Para 
isso, clique duas vezes sobre o nome do atributo criado. Uma nova 
janela é aberta, devendo-se selecionar em “Type”, a opção “Field” para 
ambas as opções (Figura 91). Aparecem duas opções de “arco_OD_3D” 
disponíveis, uma para percorrer o arco no sentido origem-destino e 
outra para destino-origem. No campo “Value” selecione para “From-
To” o valor respectivo que foi calculado na tabela de atributo, “tobler_
hr_OD”. Em seguida para o sentido inverso, i.e., “To-From”, selecione 
“tobler_hr_DO”.

Figura 91. Configuração dos 
valores dos campos para o custo 
pela velocidade de Tobler.

Também pode ser criado um novo custo, visando enriquecer o 
processo, a partir do cálculo do caminho otimizado, considerando-se 
também a distância real calculada. Para isso, adicione um novo custo 
com o nome “Dist_3D” com as opções “Cost”, “Meters” e “Double” 
selecionados, Figuras  92 e 93. Feito isso, clique duas vezes sobre o 
novo custo criado e selecione novamente a opção “Field” para o campo 
“Type” e “dist_OD_3D” para “Value”; clique em OK.
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Figura 92. Adição de um novo 
atributo (“Dist_3D”) como custo 
adicional. 

Figura 93. Configuração dos 
valores dos campos para o custo 
pela distância tridimensional. 

g) A próxima janela é usada para configurar os sistemas multimodais, 
como, por exemplo, carro, caminhão, navio, ou um produtor que 
faça uma parte do percurso a pé e outra usando uma canoa. Para 
este nosso estudo de caso, deixe em branco e clique em “Avançar 
>”.

h)	 A próxima janela possibilita configurar as instruções detalhadas 
para cada mudança de trecho do percurso (mudança de ruas, 
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entroncamentos de rodovias, cruzamentos com semáforos etc). 
Clique em “Directions...” e, na janela seguinte, selecione “id_OD” 
para “Name” e clique OK, e “Avançar” (Figura 94).

Figura 94. Configuração da informação de direção. 

i) Na janela seguinte, selecione a opção “Build Service Area Index” 
e clique em “Avançar”. Esse procedimento reduz o tempo de 
processamento e melhora a qualidade (refinamento) das feições 
resultantes.

Por último será exibido um resumo das opções e configurações da nova 
rede a ser criada; clique então em “Finish” para criar a rede. Como 
dito anteriormente, a extensão “Network Analyst” trabalha somente 
com dados vetoriais. A rede construída possuirá várias classes de 
feições, do tipo linha, junções e pontos nas interseções (Figura 95). 
A partir dessas estruturas derivadas dos dados originais já é possível 
identificar, por exemplo, a melhor rota, com base no algoritmo de 
Dijkstra. Vale ressaltar que, ao final do processo de criação de uma 
rede, é automaticamente gerada uma classe de feições do tipo pontos 
(junctions), associada aos nós extremos dos arcos e às interseções.
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Figura 95. Conjunto de dados em rede criado a partir da classe de feições 
original “arco_OD_3D” e as respectivas classes de feições derivadas, 
“Trilhas_rede” (arestas, i.e., arcos) e “Trilhas_rede_Junctions” (junções, i.e., 
interseções). 

Figura 96. Caminho de acesso e destaque para a habilitação da  extensão 
“Network Analyst”.  

Otimização de rotas
A construção de rotas otimizadas se dá a partir da ferramenta “New 
Route”, disponível na caixa de ferramentas Network Analyst da 
ArcToolbox. Para acessá-la, deve-se primeiramente, habilitar a extensão 
“Network Analyst”, acessando o menu “Customize > Extensions”. Na 
janela que se abre, ative a opção “Network Analyst” (Figura 96). Em 
seguida ancore essa extensão na parte superior da janela do ArcMap, 
junto às demais  já habilitadas.
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Criação de uma nova rota
Na barra de ferramentas “Network Analyst”, abra a lista “Network 
Analyst” e selecione a opção “New Route” (Figura 97). Ao clicar nessa 
opção, aparece em “Table of Contents” um novo grupo de camadas 
(Layers), ainda sem quaisquer classes de feições associadas a elas, 
porém contendo a simbologia apropriada. As informações necessárias 
para a construção da rota serão inseridas posteriormente.

Figura 97. Caminho de acesso e 
destaque para a ferramenta “New 
Route” para criar se uma nova 
rota. 

Em seguida devem ser indicadas as localizações de parada ou “Stops”. 
Na janela de conteúdos do “Network Analyst” (Figura 98), posicione 
o cursor sobre o nome da camada “Stops” e clique com o botão 
esquerdo do mouse, ativando-a (Figura 98A). Agora, na barra de 
ferramentas “Network Analyst”, clique na opção “Create Network 
Location Tool” (Figura 98B), que possibilita a adição manual (interativa) 
de pontos. Há duas opções na barra de ferramentas: uma para inserção 
dos pontos ao longo dos arcos da rede, e outra para localização dos 
pontos exatamente sobre junções. É oportuno ressaltar que, ainda 
que a visualização das feições (arcos e junções) de uma rede esteja 
desabilitada, qualquer ponto adicionado será movido para a junção 
ou para o arco mais próximo, observada a tolerância vigente. Depois 
de ativada a ferramenta, como exemplo, crie dois pontos quaisquer 
dentro da área de estudo. Para tanto, posicione o cursor sobre o local 
escolhido como origem da rota (Figura 98C), dentro do painel de 
visualização das camadas (data frame), e pressione o botão esquerdo 
do mouse. Um círculo com a cor ciano será adicionado no local clicado 
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Figura 98. Processo para inclusão manual dos pontos de origem e destino da 
rota, no painel de visualização das camadas.  

e, na janela de conteúdos do Network Analyst, será adicionado um 
ponto de parada, identificado com o rótulo “Graphic Pick 10”, que neste 
exemplo aparece como o de número 10, porque foram feitos dez testes 
na área de trabalho; a numeração é sequencial. Em seguida desloque 
o cursor para o ponto escolhido como destino e clique novamente 
com o botão esquerdo do mouse (Figura 98D). Outro círculo ciano 
será adicionado no local clicado e, na janela de conteúdos do Network 
Analyst, será adicionado um novo ponto de parada, identificado como 
“Graphic Pick11”.

Antes de resolver o problema de se identificar a rota otimizada, é 
necessário configurar qual atributo será tomado como referência 
para os custos de se percorrerem os arcos da rede. Para isso, clique 
na opção “Route Properties”, localizada no canto superior direito 
da janela de conteúdos do “Network Analyst” , (Figura 99A). Na 
janela “Layer Properties”, vá até a aba “Analysis Settings”, clique 
na lista “Impedance” e então selecione o atributo “Tempo_tobler 
(Hours)”. Dessa forma, será encontrada a rota com o menor tempo 
de caminhada para ir do ponto 1 ao ponto 2. No painel inferior 
direito (Directions) dessa mesma janela, selecione “Meters” para 
“Distance Units”, marcando também a opção “Use Time Attribute” e 
selecionando o mesmo atributo adotado para a impedância, ou seja, 

D

C

B
A
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“Tempo_tobler (Hours)” (Figura 99B). A configuração das opções do 
painel “Directions” somente fará sentido se o o objetivo é detalhar a 
sequência de trechos que compõem a rota otimizada. Clique em OK 
para efetivar as alterações e fechar a janela.

A

B

Figura 99. A) Acesso à janela de 
configuração das propriedades 
da rota; e B) Seleção do atributo 
usado como impedância no 
cálculo da rota otimizada.

Figura 100. Aba de ferramentas do “Network Analyst” com destaque para 
opção de solução do problema (“Solve”).

Terminada a configuração do problema de rede, clique na opção 
“Solve” da barra de ferramentas “Network Analyst” (Figura 100) para 
resolvê-lo e, assim, encontrar a rota ótima, que será então apresentada 
na moldura de dados do ArcMap.

A rota otimizada, considerando-se o tempo de caminhada de Tobler, 
ligará os dois pontos respeitando primordialmente a declividade do 
terreno. Se não se especificar outro atributo, por “default” a rota é 
calculada baseada apenas no comprimento de cada arco, resultando no 
trajeto mais curto. Na Figura 101 apresentam-se duas rotas otimizadas: 
A) adotando o comprimento dos arcos como impedância; e B) adotando 
o tempo de caminhada de Tobler. Ao se comparar as duas opções 
observa-se que a rota pelo tempo de caminhada de Tobler respeita, 
sempre que possível, o relevo, evitando o cruzamento em relevos 
acidentados e a rede hidrográfica.
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Figura 101. Comparação das rotas conectando dois pontos definidos 
manualmente, adotando-se como custo: A) Comprimento dos arcos; e B) 
Tempo de caminhada de Tobler. 

A B

Analisando-se a rota A, era de se esperar que o percurso de menor 
distância fosse uma linha reta unindo os dois pontos. Entretanto, 
para que isso ocorresse, deveria haver, necessariamente, um arco 
reto conectando diretamente esses dois pontos. Tal situação somente 
acontecerá se a linha conectando os dois pontos formar um ângulo 
múltiplo de 45º com a horizontal. Qualquer rota de uma rede somente 
poderá ser criada passando pelos arcos que constituem a rede. 
Portanto, no presente exemplo, o trajeto do ponto 1 ao ponto 2 terá 
que ser efetuado ponto a ponto, passando pelos respectivos arcos que 
os conectam, conforme ilustrado na Figura 102. Vale destacar que esse 
resultado é perfeitamente coerente com o que seria obtido no ambiente 
raster (usando o comando Cost Path da extensão Spatial Analyst), em 
que o percurso é composto por uma sequência de células da superfície 
de custos.

Quanto à rota B (Figura 101), que está associada à minimização do 
tempo de caminhada, conforme preconizado por Tobler, seu traçado 
respeita sempre que possível a declividade do terreno, evitando regiões 
de encostas íngremes. Ao adotar o tempo de Tobler como fator de 
impedância, obtém-se um trajeto geralmente mais plano.
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Figura 102. Sequência de pontos ao longo da rota de menor distância 
conectando os pontos 1 e 2.  

No presente estudo de caso, foram escolhidos aleatoriamente os pontos 
inicial e final da rota; entretanto, é possível também adicionar pontos 
já coletados e armazenados em uma classe de feições contendo, por 
exemplo, a localização geográfica de árvores de interesse. Para isso, na 
janela de conteúdos do “Network Analyst” clique com o botão direito 
do mouse sobre “Stops” e selecione “Load Locations...” (Figura 103). 
Na janela aberta, em “Load From” selecione a camada de interesse 
(Pontos_cast_selecionados) e pressione OK.

Em seguida, na barra de ferramentas do “Network Analyst”, pressione 
a opção “Solve” para determinar a melhor rota ligando todos os pontos  
na ordem exata em que eles se encontram na classe de feições. É 
possível ainda, em “Layer Properties > Analysis Settings” (Figura 
101A), selecionar a opção “Reorder Stops to Find Optimal Route”, 
escolhendo-se manter: i) somente a primeira parada; ii) somente a 
última parada; ou iii) ambas. A opção de se reordenar a sequência de 
visitas, via de regra, reduz consideravelmente o custo da rota resultante 
(Figura 104).
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Figura 103. Processo para inclusão de pontos já coletados e armazenados em 
uma feição vetorial. 

Figura 104. Rota otimizada com base 
no tempo de caminhada de Tobler, 
para acessar todas as árvores de 
interesse dentro da área de estudo. 

Na janela de conteúdos do “Network Analyst”, ao clicar com o botão 
direto do mouse sobre “Routes” e, em seguida, em “Directions”, abre-
-se uma nova janela (“Directions (Route)”), listando todas as instruções 
acerca do percurso, mostrando, ainda, a distância e o tempo total da 
rota (Figura 105).
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Figura 105. Acesso às instruções sobre o trajeto, com o tempo total e distância 
percorrida. 

Problema do Caixeiro Viajante
O Problema do Caixeiro Viajante (PCV) ou “Traveling-salesmam 
problem” (TSP) é um dos problemas clássicos de transporte, que pode 
ser definido, basicamente, por uma lista de cidades com distâncias 
conhecidas entre elas, sendo o objetivo encontrar o menor caminho 
possível para se percorrer e visitar todas as cidades, apenas uma 
vez, e, ao final, retornar ao ponto inicial, ou seja, à cidade de origem 
(APPLEGATE et al., 2006; HOFFMANN et al., 2006; ZIVIANI, 2015).

Essa é uma abordagem que pode ser implementada para a construção 
de trilhas otimizadas com base no tempo de caminhada de Tobler. 
O custo de Tobler (tempo de Tobler) poderá ser então utilizado para 
determinar o melhor acesso às árvores de interesse de uma população, 
ou, ainda, pontos intermediários estratégicos (armazéns ou pátios de 
baldeio) para concentrar temporariamente a produção. Por exemplo, 
com o uso da ferramenta “New Location-Allocation”, disponível na lista 
“Network Analyst”, é possível definir a quantidade desejada de pontos 
estratégicos para acesso a determinada quantidade de árvores ou 
setor da área. Pode-se ainda fazer a subdivisão da área de acordo com 
bacias hidrográficas, utilizando-se os recursos disponíveis na caixa de 
ferramentas “Hidrology” da extensão “Spatial Analyst”. 
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Figura 106. Caminho de acesso e destaque para a ferramenta “New Vehicle 
Routing Problem” para solução via Problema do Caixeiro Viajante-PCV. 

Figura 107. Destaque para a seleção de um ponto de localização de uma árvore 
para início e final da rota. 

Nesse exemplo, visando à construção da rota otimizada via PCV, será 
utilizada como ponto de destino a localização geográfica de árvores 
da castanheira (Bertholettia excelsa Bonpl.), identificadas no inventário 
florestal como as mais produtivas, sendo, portanto, maior o interesse 
na exploração dos frutos destas. Acesse a barra de ferramentas 
“Network Analyst” e escolha “New Vehicle Routing Problem” (Figura 
106). Quando o objetivo é obter a solução para o PCV com base no 
tempo de caminhada de Tobler, essa é a melhor opção para se modelar 
o problema de roteamento.

A seguir será definido o ponto de origem e final da rota. Nesse 
exemplo, escolheu-se arbitrariamente a primeira árvore da tabela de 
atributos da classe de feições “Pontos_cast” (Figura 107).
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Após selecionada a árvore, esta deve ser inserida pela opção “Depots” 
na janela de conteúdos do “Network Analyst”, clicando-se com o 
botão direito do mouse em “Depots” e, em seguida, na opção “Load 
Location”. No campo “Load From” da janela “Load Locations”, selecione 
a camada de interesse e certifique-se de que a opção “Only load 
selected rows” esteja selecionada, garantindo, assim, que somente o 
ponto selecionado será adicionado; mantenha em “Location Position > 
“Use Geometry”> “Search Tolerance” igual a 15 (Figura 108A). Feito 
isso, serão adicionados os pontos restantes de localização das árvores 
como os de paradas intermediárias. Assim, na tabela de atributos 
da classe de feições contendo a localização de todas as árvores, 
selecione a opção “Switch Selection” para inverter a seleção vigente 
(Figura 108B), garantindo que os demais pontos de castanheiras sejam 
selecionados, excetuando-se o primeiro, que foi o escolhido como 
ponto inicial.

A B
Figura 108. Processos: A) Para inclusão da árvore selecionada como início e 
final da rota; e B) Tabela de atributos com destaque para a inversão da seleção 
para os pontos atribuídos como destinos. 

Novamente, na janela de conteúdos do “Network Analyst”, clique com 
o botão direito do mouse em “Orders” e selecione “Load locations”. 
Na janela que se abre, escolha a mesma camada especificada 
anteriormente em “Load From”, com a opção “Only load selected rows” 
selecionada (Figura 109).
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Figura 109. Processo para inclusão das árvores selecionadas como pontos de 
parada da rota. 

É preciso ainda indicar nas propriedades da rota qual é o ponto inicial 
e final, além de alguns outros ajustes importantes. Na janela de 
conteúdos do “Network Analyst”, posicione o cursor sobre “Routes”, 
clique o botão direto do mouse e acesse a opção “Add Item” (Figura 
110). Na janela aberta (“Properties – Routes”), configure as opções 
“StartDepotName” e “EndDepotName”, selecionando o ponto indicado 
como o início e fim do trajeto; nesse exemplo, o ponto Location 1. É 
importante lembrar que existe a opção “MaxOrderCount”, cujo valor-
padrão é 30. Se o conjunto de dados que se está trabalhando exceder 
esse limite, será necessário alterar esse valor; caso contrário, o ArcMap 
buscará apenas os 30 melhores pontos para a solução da rota. Desse 
modo, mude o valor de 30 para 41 (42 árvores ao todo, menos 1). 
Feito isso, clique no botão OK.

Figura 110. Configuração das propriedades 
da rota com destaque para especificação dos 
pontos inicial e final da rota e para o número 
máximo de paradas.  
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Clique em “Layer Properties”,       , vá até a aba “Analysis Settings” 
para configurar as unidades corretas. Selecione as opções na caixa 
“Settings”, usando “Tempo_tobler (Hours)” para “Time Attribute”; 
“Hours” para “Time Field Units” e “Meters” como unidade de distância 
para “Distance Field Units” e  também para “Distance Units” na caixa 
“Directions” (Figura 111).

Figura 111. Acesso e configuração das propriedades para cálculo da rota, 
especificando-se o tempo de caminhada de Tobler como custo. 

Após efetuadas todas as configurações, pressione o botão “Solve” 
da barra de ferramentas “Network Analyst” para resolver o problema. 
Será, então, gerada a rota otimizada, passando por todos os pontos e 
retornando ao ponto inicial especificado (Figura 112).

As rotas geradas são, por default, temporárias; porém, podem ser 
salvas como uma nova classe de feições, utilizando-se a opção de 
exportação de dados, disponível na tabela de conteúdos do “Network 
Analyst”, clicando-se com o botão direito do mouse sobre “Routes”. 
É possível também visualizar o tempo total e a distância percorrida, 
clicando-se com o botão direito do mouse em “Route” e selecionando 
“Directions” (Figura 113).
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Figura 112. Rota otimizada para visitar um conjunto de árvores de interesse 
dentro da área de estudo, usando-se o tempo de caminhada de Tobler como 
impedância. 

Figura 113. Acesso as informações de direções da rota, com o tempo total e 
distância percorrida.

Entrepostos em análise de redes
Pode-se adotar também a localização de entrepostos para 
abastecimento e pós-transporte e acesso às demais árvores, sendo 
possível gerar um traçado para esses pontos e definir a partir destes 
quantas árvores são atendidas. Para isso, vamos iniciar escolhendo 
o conjunto de dados, que neste caso será a localização geográfica 
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das árvores. Novamente, acesse a aba de ferramentas do “Network 
Analyst” e escolha “New Location-Allocation” (Figura 114). Quando o 
objetivo é obter a solução para pontos do tipo entrepostos para atender 
determinadas paradas essa é a melhor opção.

Figura 114.Caminho de acesso e destaque para a ferramenta “New Location-
Allocation” para solução via PCV. 

Figura 115.Processo para inclusão das árvores como “Facilities”. 

Com a estrutura criada, é necessário indicar quais pontos serão 
candidatos a entrepostos e quais são as demandas ou pontos a 
serem atendidos. Em “Facilities” serão adicionados os candidatos 
a entrepostos, que para este exemplo foram consideradas todas as 
árvores como potenciais. Para isso, clique com o botão direito em 
“Facilities” na janela de conteúdos do “Network Analyst”, escolhendo 
“Load Location” e em seguida em “Load From” insira a feição de 
interesse (Pontos_cast), (Figura 115).
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Figura 116.Processo para inclusão das árvores como demandas. 

Repita o mesmo processo, agora incluindo as árvores em “Demand 
Points” (Figura 116). Nessa etapa são indicadas todas as árvores ou 
pontos de parada que serão acessados; clique em OK.

Note que, nesse exemplo, todas as árvores foram consideradas como 
potenciais entrepostos e igualmente como pontos de demandas, pois 
o objetivo é encontrar dentre as árvores aquelas que podem servir 
de entrepostos para atender às demais. O arranjo para a análise irá 
depender do conjunto de dados utilizado e poderá ser adaptado da 
melhor forma que atenda aos objetivos desejados. Antes de resolver 
o problema, é necessário configurar qual custo será tomado como 
referência e a quantidade de entrepostos que se deseja. Para isso 
acesse, na tabela de conteúdos do “Network Analyst”, em “Layer 
Properties”, “Location-Allocation” (Figura 117). Na janela aberta, vá até 
a aba “Analysis Settings” e em “impedance” selecione “Tempo_tobler 
(Hours)”, ou seja, calcular a partir do tempo; deixe como padrão as 
demais opções.

Na mesma janela aberta anteriormente de “Layer Properties”, vá até 
a aba “Advanced Settings” e digite a quantidade de entrepostos em 
“Facilities To Choose” (Figura 118). Ao digitar a quantidade, que 
nesse exemplo foi usado cinco, a análise de rede definiu as melhores 
árvores para servirem de entreposto para atender as demais que estão 
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próximas a eles, sempre considerando a velocidade de Tobler, ou seja, 
a declividade. Em “Problem Type” selecione “Minimize Impedance”, ou 
seja, sempre buscando minimizar o custo de impedância, no qual já foi 
indicado pela velocidade de Tobler; clique em OK (Figura 118).

Figura 117. Acesso e configuração das propriedades do cálculo da rota para o 
tempo de caminhada de Tobler.

Figura 118. Configuração da quantidade 
de entrepostos dentro da área de estudo 
pela velocidade de Tobler. 

Por último, da mesma maneira que as outras ferramentas, vá até o 
botão “Solve”       para resolver e obter a solução do problema. O 
resultado são os entrepostos e a indicação por uma linha reta de quais 
árvores é atendida por eles (Figura 119).
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Figura 119. Rota otimizada para acesso a pontos estratégicos para acesso às 
árvores no local de estudo. 

Outra opção é a percepção do usuário com relação ao relevo, 
analisando bacias hidrográficas e ponderando pelo conhecimento da 
realidade local para a definição de entrepostos, ou ainda, adaptar 
a localização com base no conhecimento geral das características 
da área. Com as ferramentas disponíveis na extensão “Network 
Analyst” são possíveis muitas formas de análises, sendo que o maior 
aprofundamento vai depender dos objetivos do usuário.

Considerações finais

O processo de otimização de trilhas para acesso a recursos florestais 
representa uma importante ferramenta para a melhoria de processos 
produtivos nos mais diversos ambientes florestais. Com o advento 
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dos Sistemas de Informações Geográficas, novos produtos têm sido 
gerados e mais conhecimentos se adquirem acerca do tema. 

A busca por soluções tecnológicas aplicadas ao uso de recursos 
florestais é a direção para que o manejo e a exploração de produtos 
florestais ocorram de forma otimizada e harmônica. Assim, pelo 
caráter inovador da metodologia aqui apresentada, esta pode e deve 
sofrer alterações e melhorias com o desenvolvimento de diferentes 
abordagens, destacando-se o envolvimento das comunidades e os 
saberes locais.
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